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Safety Precautions 

For your safety and protection of the Braille eMotion 40, please read and 

abide by the following safety precautions. 

1. The input voltage of the AC adapter is 100V - 240V, and the outputs 

are DC 5V 3A and 9V 2A 

2. The battery may not be fully charged when it is shipped. Before you 

use the Braille eMotion 40, you should ensure the battery is fully 

charged.  

3. When you use the Braille eMotion 40 with the battery for the first 

time, the battery status may not be displayed accurately. To avoid 

this, leave the Braille eMotion 40 connected to the AC adapter for 

about five hours with the unit turned on. If you want to use the Braille 

eMotion 40 immediately, you may use it while it is charging. 

4. There is a risk of explosion if the battery is replaced by an incorrect 

type. Please make certain to use only battery packs produced 

specifically for the Braille eMotion 40 by SELVAS Healthcare. Please 

dispose of used batteries according to the instructions. 

5. If the usage time is less than 50% as compared to the stated battery 

run time in the product specifications, even after a full charge, it is 

recommended that you replace the battery. 

6. If you drill into or disassemble the product or battery using a sharp 

point, it may cause electric shock, explosion or fire. 

7. When you are using the Braille eMotion 40 on battery power, the 

status of the remaining battery power is announced when the battery 

charge is low. When the battery’s charge falls below 15 percent, 

connect the AC adapter to the unit for recharging. If the remaining 

battery charge drops to five percent, and the unit is not connected to 

the AC adapter, the Braille eMotion 40 goes in to Sleep Mode one 

minute after the announcement of the battery’s status. If the battery 

level falls to 2%, the unit shuts down to preserve settings, etc. The 



amount of battery life per charge varies depending on the options 

you have set and the number and type of tasks you are running.  

8. Your Braille eMotion 40 needs to be handled with care. The Braille 

eMotion 40 is a very delicate machine. Please handle the unit in a 

proper, careful manner. The Braille eMotion 40 is very sensitive to 

dust. Make sure to keep it away from dusty environments. 

9. The Braille cells are very sensitive, intricate parts. If the Braille cells 

are not working properly due to the presence of dust or for any other 

reason, please contact our repair center, or the dealer from whom 

you purchased the Braille eMotion 40 for support. 

10. You should register your Braille eMotion 40 in order to ensure further 

maintenance, service, and upgrade information. In the US, please 

visit www.hims-inc.com, to register your information. If you have any 

trouble when registering your information, please contact the dealer 

from whom you purchased your Braille eMotion 40 for help. 

International customers should contact their regional dealer for 

product registration information. 

11. Do not disassemble the Braille eMotion 40 yourself. Do not have 

anyone else who is not authorized by HIMS take apart the Braille 

eMotion 40. If an unqualified person disassembles the unit, serious 

damage may occur. If an unauthorized person disassembles the unit, 

it is excluded from any free maintenance, and the warranty becomes 

void. If any liquid or external force damages the unit, it may also be 

excluded from free maintenance, even if the damage occurs during 

the warranty period. The Braille eMotion 40 contains a Liquid 

Contact Indicator sticker that will change color if the unit comes in 

contact with water or other liquids. This indicator will not activate 

under humid or other conditions that fall within the product’s normal 

environmental requirements.  

12. Do not leave your Braille eMotion 40 in closed, high temperature 

environments such as inside a car on a hot summer day, as the 



battery may be damaged or catch fire. Please do not let your Braille 

eMotion 40 remain in such environments for long periods of time.  

13. To prevent possible damage to your hearing, do not listen to audio 

at high volume levels for long periods. 

Operation is subject to the following two conditions. 

1. This device may not cause harmful interference, and 

2. This device must accept any interference received, including 

interference that may cause undesired operation. 

This equipment can generate, use and radiate radio frequency energy and, 

if not installed and used in accordance with the instructions, may cause 

harmful interference to radio communications. However, there is no 

guarantee that interference will not occur in a particular installation.  

If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment off and on, the 

user is encouraged to try to correct the interference by one or more of the 

following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

  



Battery instructions. 

- high or low extreme temperatures that a battery can be subjected to 
during use, storage or transportation; and 
- low air pressure at high altitude. 
- replacement of a battery with an incorrect type that can defeat a 
safeguard (for example, in the case of some lithium battery types); 
- disposal of a battery into fire or a hot oven, or mechanically crushing or 
cutting of a battery, that can result in an explosion; 
- leaving a battery in an extremely high temperature surrounding 
environment that can result in an explosion or the leakage of flammable 
liquid or gas; and 
- a battery subjected to extremely low air pressure that may result in an 
explosion or the leakage of flammable liquid or gas. 

 

  



FCC regulatory conformance:  

 This device complies with Part 15 of the FCC Rules. Operation is subject to 

the following two conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including 

interference that may cause undesired operation. 

NOTE: This equipment has been tested and found to comply with the limits 

for a Class B digital device, pursuant to part 15 of the FCC Rules.  These 

limits are designed to provide reasonable protection against harmful 

interference in a residential installation.  

This equipment generates uses and can radiate radio frequency energy and, 

if not installed and used in accordance with the instructions, may cause 

harmful interference to radio communications.  However, there is no 

guarantee that interference will not occur in a particular installation.  If this 

equipment does cause harmful interference to radio or television reception, 

which can be determined by turning the equipment off and on, the user is 

encouraged to try to correct the interference by one or more of the following 

measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help 

NOTE: The manufacturer is not responsible for any radio or TV interference 

caused by unauthorized modifications to this equipment. Such modifications 

could void the user’s authority to operate the equipment.  

RF Exposure Information and Statement 



The SAR limit of USA (FCC) is 1.6 W/kg averaged over one gram of tissue. 

Device types Tablet PC (FCC ID: 2AL4D-B340T) has also been tested 

against this SAR limit. The highest SAR value reported under this standard 

during product certification for use on the body is 2.4GHz:0.85W/kg, 

5GHz:0.70W/kg. This device was tested for typical body-worn operations 

with the back of the handset kept 0mm from the body. To maintain 

compliance with FCC RF exposure requirements, use accessories that 

maintain a 5mm separation distance between the user's body and the back 

of the handset. The use of belt clips, holsters and similar accessories 

should not contain metallic components in its assembly. The use of 

accessories that do not satisfy these requirements may not comply with 

FCC RF exposure requirements, and should be avoided. 

5G WIFI indoor used only 

 

  



I. Your Braille eMotion 40 packing box should 

contain the following items: 

1) Braille eMotion 40 

2) Carrying Case 

3) AC Adapter 

4) USB C to A cable 

5) Earbuds 

6) Braille Commands Summary 

 

II. How to use this manual 

In this manual you will see references to hot keys and shortcut keys. These 

keys refer to ways to access menus and functions quickly by using a 

combination of keystrokes. Please note that not all hot keys and shortcut 

keys will work from every location on the Braille eMotion 40. Some hot keys 

and shortcut keys are program specific, thus, they require that you be within 

a specific program for them to work. 

Shortcut keys refer to keystrokes used to quickly activate a function from 

within a menu. Hot keys refer to keys that will activate a function regardless 

of where you are within the program. When functions are described in this 

manual, shortcut keys are shown in parentheses, and hot keys are shown in 

quotes. 

This user manual notes how to press hot keys and shortcut keys in the 

following manner: Keys that are to be pressed at the same time are 

separated by a - (dash). When you see “Space-b (dots 1-2),” this means that 

you should press “Space” and dots 1 and 2 simultaneously. 

If you are unable to find a solution to a problem within the manual, or if you 

need assistance with the Braille eMotion 40, please email us at 



hims.support@selvashc.com. You may also visit us on the web at 

www.himsintl.com; or, you can call us at +82-42-879-3000. 
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1. Introduction 

1.1 What is the Braille eMotion 40? 

The Braille eMotion 40 is a HIMS branded smart Braille display developed 

and manufactured by SELVAS Healthcare, for people who are blind and 

visually impaired. The Braille eMotion 40 has a variety of powerful 

capabilities, including the following. 

1. Use the Braille eMotion 40 as a USB or Bluetooth Braille display with 

a compatible screen reader, such as JAWS, NVDA, SuperNova, 

Microsoft Narrator, VoiceOver for Mac and iOS and TalkBack for 

Android™. 

2. Read TXT, BRF, RTF, PDF, EPUB, and Microsoft Word files.  

3. Take notes or create documents using the Notepad. 

4. Play audio and video media, and read DAISY text and audio books,. 

5. Perform scientific and graphic calculations, and set alarms and timers. 

6. Create high quality recordings, using the internal microphones, or a 

USB audio device. 

 

1.2 Physical Tour 

To get the most from your Braille eMotion 40, it is important to become 

oriented to the buttons and ports as well as learning their functions. This 

section will orient you to your Braille eMotion 40. 

Place the Braille eMotion 40 on a desk or table top with the Braille display 

nearest you.  

 

1.2.1 THE TOP PANEL 

On the top face of the Braille eMotion 40, near the top edge,  are located 8 

Perkins-style keys, with an additional, horizontally oriented button in the 



center. To the left of the horizontal button are dots 1, 2, 3, and “Backspace”, 

(or dot 7). To the right of the horizontal button, are dots 4, 5, 6, and “Enter), 

(or dot 8). The horizontal button in the center is used to change input 

parameters, such as the current Braille code or grade being used.  

To the upper left of the “Backspace” key, there are 3 small square keys with 

Braille labels. The left-most key is labeled with a W, and controls Wi-fi. Short 

press the Wi-fi key to toggle Wi-fi on and off. Long press to open the Internet 

Setup dialog. To the right of the Wi-fi key, is the Bluetooth key, labeled with 

the letter B. It operates similarly to the Wi-fi key, with a short press toggling 

Bluetooth on and off, and a long press opening the Bluetooth Manager. To 

the right of the Bluetooth key is the Connectivity button, labeled with the letter 

C. Short press the “Connectivity” button to bring up the Pairing list: long press 

it to open the connectivity menu. 

To the right of the “Enter” key, is a larger squarish button with rounded 

corners. This is the “Power” key. When the eMotion 40 is running, short press 

this key to bring it in in and out of Sleep Mode. Long press it to boot up from 

shut down, or if running, to bring up the Power options. Hold the Power key 

for 10 seconds, to force a reboot if the unit is not responding, or is behaving 

erratically. 

To the left and right of the keyboard are located the rectangular stereo 

speaker grills. 

Below the Perkins keyboard is a 40 cell Braille display. Above the Braille 

display, there are cursor routing buttons corresponding to each of the 40 

Braille cells. When you are editing documents, you can use these keys to 

route your cursor to the character of the corresponding Braille cell. The 

cursor routing keys also serve as shortcut keys for navigating lists and 

groups of fields in certain places on the unit. A dot is placed on each 5th 

cursor routing button for easier orientation.  



On each side of the Braille display are two capsule shaped keys. These are 

the "UP" and "DOWN" scroll keys. The scroll keys are used to scroll the 

Braille display through menus, fields, lists or text. You can use the scroll keys 

to scroll by display length, paragraph, line, sentence, or character. You can 

set the navigation unit of the scroll keys in the "Global Options". (See chapter 

3.)  

Below the Braille cells is a slightly sloped section near the center of the 

device. This section contains 3 keys. From left to right, these are the Control 

key, the spacebar, and the Alt key. 

 

1.2.2 THE FRONT EDGE 

The front edge contains several controls. From left to right are located the 

Left Cursor button, F1, F2, the left stereo microphone, the Home key, F3, F4, 

the Right Cursor button, and the Micro SD card slot. The left and Right Cursor 

buttons, work together with other keys to control various aspects of 

navigation. Press both Cursor buttons together to cycle the movement unit 

by which the Scroll keys navigate. Function keys 1-4 perform various 

operations, depending on your position on the unit, and will be described in 

context in the subsequent chapters of this manual.  

In the center of the front edge is a protruding section, containing the “Home” 

button, with the stereo microphones on either side. A short press of the 

“Home” button opens the main menu from anywhere on the device. Two 

short presses of the “Home” button opens the Task Manager. Three short 

presses of the “Home” button toggles voice output on/off. Holding the “Home” 

button for 3 seconds locks and unlocks the keyboard. 

Near the right end of the front edge is a small, rectangular slot for inserting 

the Micro Sd card for additional storage. Press the Micro SD card in to the 

slot until you feel it 

click in to place. To release it, gently press in on the card and release. 



The card will pop out enough for you to grasp it with your fingers and 

remove it.  

 

1.2.3 THE RIGHT EDGE 

The Right edge of the Braille eMotion 40 contains the  USB C port, the 

headphone jack, and the Voice Control and Volume buttons. . The USB C 

port nearest the rear of the unit is for powering and charging the unit, as well 

as connecting to a PC for use as a Braille display, and to transfer data. Use 

the 3.5 mm audio jack to connect headphones or external speakers.  

Below the headphone jack is the “Voice Control” button. The Voice Control 

button allows you to quickly access Speed, volume, and pitch settings for the 

TTS, or audio speed, volume and equalizer during audio playback. Cycle 

through the settings with repeated presses of the Voice Control button, and 

use the Volume buttons  to adjust the chosen setting. By default, the Volume 

Up and Down buttons will control the volume of the content to which you are 

currently listening. If you are listening to media, they control media volume. If 

you are reading a DAISY text book or document file, they adjust the volume of 

the reading voice. If you are in a menu or list, by default, the Volume buttons 

control the eMotion’s Main Volume.  

Long press the “Volume Down” button to obtain battery status. Long press the 

“Volume Up” button to announce the Date and Time. Long press the “Voice 

Control” button to initialize voice/audio settings for your current context. 

 

1.2.4 THE LEFT EDGE 

The left edge of the Braille eMotion 40 contains the “Record” button, and the 

USB host port. 



The button nearest the rear is the “Record button. Press the record button 

quickly to access previously recorded content. Long press it to make a new 

recording. 

Nearer the front of the device is a USB A host port, for connecting drives and 

QWERTY keyboards to the Braille eMotion 40. 

 

Congratulations! You are now familiar with the basic functions of the buttons 

and ports of the Braille eMotion 40. The rest of the manual discusses each 

function in greater detail to help you maximize the potential of your Braille 

eMotion 40. 

 

1.3 Hardware Specifications 

1. Operating system: Android™ 12 

2. Internal storage: 64GB UFS 2.1 (around 43GB available to user). 

3. RAM: 4GB LPDDR4X. 

4. CPU: Octa (4 x 2.0 GHz Kryo Gold, 4 x 1.8 GHz Kryo Silver) 

5. Battery: Li-ion 3.8V, 5000 mAh (Built-in). 

6. Battery running time: About 19 hours (with Braille and TTS, internal 

speaker at mid volume)  

7. Keyboard: 9 key Perkins-Style Braille keyboard, Control and Alt, 4 function 

keys, 40 cursor routing keys, 4 scroll buttons, 2 cursor buttons, home key 

and input selector button. 

8. Braille display: 40 refreshable Braille cells. 

9. Wireless:   Wi-Fi 802.11a/b/g/n/ac, Dual-band;  Bluetooth

 5.0(HID, A2DP, HFP) 



10. Interface: USB C x 1, USB A X 1, 1 Micro SD card slot (FAT32 and exFAT 

supported) 

11. Sound: Internal stereo speakers, stereo headphone jack. 

12. Voice recording: Internal stereo MEMS microphones, headset 

microphone, USB audio supported.  

13. Vibrate motor: installed. 

 

1.4 Memory on the Braille eMotion 40 

The Braille eMotion 40 has 4GB of RAM (random access memory) and 64GB 

of flash memory. The RAM is memory reserved for running programs. RAM 

is a temporary storage area for any program files that are running or any 

currently open documents. The data in the RAM area disappears if your 

battery depletes, and the AC adapter is not connected. The RAM data also 

disappears when Braille eMotion 40 reboots for any reason. This means, if 

you have an open document which you have not saved, the unsaved data 

disappears. 

 

2. Basic Functions of the Braille eMotion 40 

2.1 How to Enter Commands 

The commands used to operate the Braille eMotion 40 are comprised of 

various combinations of the Braille and function keys. In this user manual, 

the "-" (dash) is used to indicate that keys should be pressed simultaneously. 

For example, "Space-Z" indicates that the user should press "space" and Z 

at the same time. This manual also contains expressions like "Space-2-4-6". 

This means that the spacebar with dots 2, 4, and 6 should be pressed and 

released simultaneously.  



In a menu or dialog, when your cursor is placed on your desired command, 

you can execute most commands by pressing "Enter". To cancel a function 

or close a program or menu, and return to your previous location, press 

"Space-Z". 

 

2.1.1 BASIC ALERTS AND MESSAGES 

There are instances where the Braille eMotion 40 alerts you to events for 

which you have asked it to notify you.  

Braille eMotion 40 system messages are displayed and spoken, and 

automatically disappear when any key is pressed, or after a set number of 

seconds. For example, when you connect the AC adapter to the Braille 

eMotion 40, the Braille eMotion 40 speaks the message "AC adapter 

connected." When you disconnect it, the Braille eMotion 40 says, "AC 

adaptor disconnected." You can determine for how much time system alerts 

remain on the Braille display in the “Braille Options” described in the next 

chapter. 

 

2.2 Menu Concepts 

Menus on the Braille eMotion 40 provide you with a list of programs, actions, 

or options from which you can select. If a menu item has a sub menu, 

selecting it brings up another list of choices. 

When using a program on the Braille eMotion 40, press "Space-M" or F2 to 

bring up its menu. Press the "Up" scroll key or "Space-1" to move to the 

previous item, and press the "Down" scroll key or "Space-4" to move to the 

next item.  

To move to the first item in the menu, press "Space-1-2-3." To move to the 

last item in the menu, press "Space-4-5-6." When placed on the first item of 

a sub menu, pressing "Backspace" returns you to the upper Menu. To repeat 



the current item, press "Space-R". To open a sub menu or execute the 

current item, press “Enter”.  

You can also quickly jump to and execute a menu item by pressing the menu 

item's shortcut key, usually the first letter of the item name. Often menu items 

can also be executed instantly, directly from your current position in the 

program, with a hotkey. 

Shortcut keys are displayed in parentheses following the menu names. 

Hotkeys generally consist of a modifier such as "Enter," "Space," or 

"Backspace", pressed simultaneously with a letter or dot combination. These 

are displayed following the shortcut keys. 

For example, if you are in the Notepad, and press "Space-M" or "F2," then 

press "Enter" on "File," you hear "New (n) pull down Enter-n". The word 

"New" is the menu option. You would press the letter N to jump to "New" from 

within the "File" menu. Press "Enter-n" to access the "New" document 

command from anywhere in the Notepad. The n is the shortcut key and 

"Enter-n" is the hotkey. It is important to note that some hotkey commands 

are global, thus will work from anywhere on the unit, and some are program 

specific. For example, if you want to activate the "new document" option in 

the Notepad, you cannot press "Enter-n" from the main menu to activate this 

option. You must be in the Notepad for "Enter-n" to activate the "new 

document" command. However, if you wish to activate the "display time and 

Date" option in the "Utilities" menu, this can be done from anywhere on the 

unit using "Space-T" as this is a global hot key.  

Let's begin going through the various menus. First, turn the unit on as 

explained in chapter 1. Now, bring up the "Program" menu by pressing the 

"Home" key. The "Program" menu is the main menu of the Braille eMotion 

40. You can access all of the programming, option settings, utilities, and help 

from this menu.  



The "Program" menu consists of 7 programs: My Documents, File Manager, 

Notepad, Connectivity, Document Reader, DAISY Player, and Media Player; 

then 3 sub menus: Utilities, Settings and Help.  

The first item in the "Program" menu is "My Documents". If "Space-4" is 

pressed, the next menu item is displayed and spoken. Pressing "Space-4" 

repeatedly, continues your navigational progress down the list of items in the 

"Program" menu. When you reach the bottom of the list, the “Help" menu 

item is displayed as it is the last item in the "Program" menu.  

You could also jump quickly to the "Help" menu item by pressing "Space-4-

5-6" when "My Documents" is displayed. Press "Space-1-2-3," and the 

Braille eMotion 40 jumps back to the top. Press "Enter" on an item you want 

to execute or open. If you are in a submenu, and wish to return to the main 

"Program" menu, press "Space-E" or F4.  

The "Utilities" menu contains the “Voice Recorder”, "Calculator", “Display 

time and Date", "Wake Up Alarm", "Stopwatch", “Backup/Restore Flashdisk”, 

"Format", "Sleep Timer" and "Upgrade Braille eMotion Firmware". 

The "Settings" menu contains “Braille Options”, “Voice Options”, “Global 

options”, "Set Time and Date", "Setup Internet", "Bluetooth Manager", 

"Backup/Restore Settings", and "Initialize Braille eMotion Options”.  

The "Help" menu contains “User Guide” and “Information”. The “User Guide 

item opens a navigable version of the Braille eMotion User 40 Manual. The 

“Information” dialog provides the copyright and version of the Braille eMotion 

40, as well as the operating system version, the version of the Braille eMotion  

40firmware, and other useful items such as Mac address and Key number. 

When the "information" dialog is open, you can save the information about 

the Braille eMotion 40 by pressing "tab (Space-4-5 or F3)", to navigate to the 

"Save" button and press "Enter". The unit displays "Successfully saved", and 

returns you to the "Save" button. The saved file is named "bs-information.txt", 

and is stored in "flashdisk" for easy access. 



For more information on a specific program, please see the section of this 

user manual related to that program.  

The "Home" command for accessing the "Program" menu is an example of 

a global hotkey. This means that pressing the "Home" key takes you to the 

"Program" menu immediately from anywhere on the Braille eMotion 40.  

There are also global quick launch commands for most Braille eMotion 40 

programs, usually comprised of either F1 or F3 and a letter or dot 

combination. These quick launch commands immediately launch their 

associated application from anywhere on the Braille eMotion 40. See the 

Commands Summary section for a complete list of the quick launch 

commands.  

 

2.2.1 CONTROL SYMBOLS 

The Braille eMotion 40 uses several control symbols to note the type of 

information being displayed: examples are list items, menus, and edit boxes. 

These symbols can appear "Before" or "After" the text, or the appearance of 

this information may be set to "off", determined by the "Control information" 

setting in the "Global Options". For example, if "Control information" is set to 

"before", and you bring up the Notepad’s program menu, The Braille eMotion 

40 displays, "MN File (f) pull down". 

The following table shows the types of controls and the symbols that are 

used to indicate them. 

 

Name 

Symbol 

Comments 

Menu 



MN 

A menu that has submenus. 

Menu item 

MI 

A menu item that does not have a sub menu. 

List item 

LI 

An item that is part of a list. 

Edit box 

EB 

After this symbol, the edit box name is displayed. You can find the edit box 

after the edit box name. Edit boxes that begin with the symbol "EB" are one 

line, such as those for a text search. 

Multi edit box 

MEB 

This indicates a multi-line edit box.  

Computer edit box 

CE 

An edit box requiring ASCII Braille input, such as when entering a file name. 

Combo box 

CB 

Indicates a combo box in which you can choose an item by pressing the up 

scroll button or the down scroll button. 

(Ex: "CB Type:" in the "Open dialog box" of the Notepad) 

Edit combo box 



ECB 

choose the desired item by pressing the up or down scroll button, or by 

directly typing in the item name. 

(Ex: "ECB File name: (cursor) in the "Open dialog box" of the Notepad 

program) 

Prompt button 

PB 

PB follows any question in which you have to choose "Yes" or "No." You can 

toggle between "Yes" and "No" by pressing "Space" or "Backspace".  

(Ex: When you exit from the Notepad, "PB Save: Yes")  

Static box 

ST 

ST indicates the current status. 

(Ex: "ST noname.hbl/insert mode/write" in the Notepad program) 

 

The symbols enable you to understand what type of input control or menu 

you are working with. For example, if "MN," "MI," or "LI" are displayed, you 

know you can move from one item to the previous and next items by pressing 

the "Up" and "Down" scroll keys. If "ECB," "EB," "CB," or "MEB" are displayed, 

you know you are in an input area where you must type. If "BT" is displayed, 

you can press "Enter" to activate the "button". 

 

2.3 Using the Function Keys 

There are four function keys on the Braille eMotion 40. You can use these 

function keys to open the menus, cancel tasks, and move to other items.  



The "F1" key opens the File Search dialog from anywhere on the unit, and is 

used in combination with other keys to open various Braille eMotion 40 

programs.  

From within Braille eMotion 40 programs, the "F2" key opens the program 

specific menu, similar to pressing “Alt” in Windows.  

⚫ Note: you may also use "Space-M" to perform this function.  

The "F3" key functions as "Tab ("Space-4-5")". "Space-F3" serves as "Shift-

Tab ("Space-1-2")". F3 is also used together with other keys to open Braille 

eMotion 40 programs. 

The "F4" key functions like the "Escape" key on a PC. You can also use 

"Space-E". Please note that "Escape" does not exit a program, as does 

"Space-Z" but rather, exits menus, dialogs, or prompt boxes.  

You can use the function keys in combination to perform various other tasks. 

Pressing "F1" and "F2" at the same time functions as "Page Up". Pressing 

the "F3" and "F4" keys together serves as "Page Down". "F1" and "F4" 

together opens the task list. Pressing the "F2" and "F3" keys together cycles 

through the running programs; similar to pressing "alt-tab" on your PC. The 

Task List and task switching are explained in greater detail in section 2.9. 

The keys to the left and right of the spacebar are referred to as Control and 

Alt. This is because, in applications, these keys function as Control and Alt 

on a QWERTY keyboard so that you may take advantage of keyboard 

shortcuts when they are present. In Braille eMotion 40 specific applications, 

Control and Alt operate similarly to "Space-1" and "Space-4" and provide an 

alternative method for scrolling through menus and lists.  

 

2.4 The Power Supply and the Battery Pack 

To check the battery power status, press "Space-1-6." The unit displays the 

following 2 items: 



1. Battery power level: expressed as a percentage of the remaining battery 

power compared to a full charge.  

2. Power source (battery, or AC power [USB C]) 

If the battery power level drops under 15 percent, the Braille eMotion 40 

displays the battery status on the Braille display, and it announces that the 

battery has less than 15 percent of its power remaining. If the battery power 

level falls below five percent, the Braille eMotion 40 gives you a warning 

indicating that your battery power level is under five percent, and the Braille 

eMotion 40 will be automatically put to sleep in one minute, unless you 

connect it to a power supply. When the level reaches 2 percent, the unit 

automatically shuts down. 

*Note: if the battery is completely depleted, the unit cannot boot. When you 

connect the Braille eMotion 40 to power in this state, a Braille message 

appears showing you that the unit is charging, and the percentage of the 

charge. This is to alert you that you must charge the device for a few minutes 

before you can boot the device.  

We recommend charging the unit to around 5% before attempting to boot the 

device. When the charging status appears, hold the Power button for around 

5 seconds. 

Before using the Braille eMotion 40 for the first time, please charge the 

battery for at least 4 hours. You may use the unit during the initial charge, 

however, it is recommended if you do, that the unit remain connected to 

power for at least 4 hours to fully charge the battery.  

Braille eMotion 40 can be charged via any USB C charger. It is compatible 

with the Quik Charge power specification, and should charge in about 4 

hours with the included power adapter. However, charging time will vary 

according to the power specification of the charger being used. 



Braille eMotion 40 will operate on average for about 19 hours on a single 

charge. However, this will also vary greatly if USB devices are connected, if 

media is playing, etc. 

 

2.5 Adjusting Volume and other properties.  

You can use the Voice Control button and the Volume buttons on the right side 

of Braille eMotion 40 to adjust the volume of media playback, the guide voice, 

and the reading voice. You can also use it to change various other settings, 

such as speed, and media equalizer. 

To adjust a setting, press the Voice Control button just above the Volume 

buttons repeatedly until you reach your desired setting. Then, use the Volume 

buttons to increase or decrease the value of that setting. 

The available settings differ depending on your location in Braille eMotion 40, 

but will always include the master (Main Volume” setting along with the context 

specific options. The following settings are available in their respective 

locations on Braille eMotion 40. 

1) From the Home Menu: Guide Voice Volume, Guide Voice Speed and 

Guide Voice Pitch. 

2) From the Media Player: Media Volume, Media Playback Speed and 

Media Equalizer. 

3) During DAISY text and document playback: Reading Voice Volume, 

Reading Voice Speed, and Reading Voice Pitch. 

4) During DAISY Audio Playback: DAISY Audio Volume, and DAISY Audio 

Speed. 

*Note: the Volume buttons will automatically return to their default setting of 

controlling the volume of the content to which you are currently listening after 



5 seconds of inactivity. You will know this has occurred, as Braille eMotion 40 

emits a short beep sound to indicate this. You can initialize all the associated 

settings for your current context to their defaults, by long pressing the Voice 

Control key. 

 

2.6 Using Speech and Braille 

When using the Braille eMotion, you can choose to read using Braille only or 

speech only. You can also use both Braille and speech simultaneously. 

However, you cannot turn off both Braille and speech as you would have no 

method of receiving information from the Braille eMotion 40. Use 

"Backspace-F2" to toggle the speech on and off. Press "Backspace-F3" to 

toggle the Braille on and off. You can also control these settings in the Global 

options. 

 

2.7 Entering Text 

In a document, "edit box" or "multi edit box" on the Braille eMotion 40, you 

can enter either grade 1 or grade 2 Braille. By default, the unit uses UEB 

Braille, and you are free to use UEB, even when writing e-mail or Web 

addresses. However, if using the traditional US Braille code, some areas of 

the unit, such as the file name edit boxes, contain a "computer edit box" 

requiring you to enter text in computer Braille.  

To enter a capital letter in computer Braille, use the upper case indicator 

(Space-U" before the letter you want capitalized. For example, if you want to 

enter H in a computer edit box, press "Space-U" then H. If you press "Space-

U" twice, caps lock is turned on. Press "Space-U" again to turn off caps lock. 

You can also press "Space-Backspace" simultaneously with the letter to 

capitalize it. To input the "at sign," you may either use "Space-U" followed by 

dot 4, or "Space-Backspace-dot 4".  



To enter numbers in contracted or uncontracted Braille, use the "number sign 

followed by the number. However, when using computer Braille, you use no 

number sign and must enter numbers as "dropped" numbers (Nemeth 

numbers).  

 

2.8 Multi-Tasking 

Braille eMotion 40 can run many tasks at once. For example, you can work 

with the Notepad while listening to music, and place calculations into a 

document at the same time. To do this, open the Media Player and play a 

music file. While the audio is playing, press the "Home" key to bring up the 

"Program" menu and launch the Notepad. 

If you try to run a program that is currently running, The Braille eMotion 40  

does not open a new instance of the program, but rather, returns you to the 

instance of the program that is already running. For example, while working 

with a document called "Notes" you decide to execute the "File Manager." 

Next, you navigate to a document called "journal" in the file list and press 

"Enter." The Notepad does not load a second time, but rather, "journal" is 

opened in the same instance of the Notepad in which "notes" is already 

loaded. You can switch among multiple open documents in a single instance 

of the Notepad or Notepad with F3 and Space-F3. Switching documents is 

explained in more detail in section 5.  

To switch between currently running programs press "F1-F4" to open the 

Task List. The Task List shows all the currently running programs in list form. 

To return to any application, simply navigate to it and press "Enter". To force 

closing of an application in this list, press "Space-D". To close all applications, 

press “F3” to tab to the “Close All” button, and press “Enter”, or press “Enter-

Space-D”. 

If you have pressed "Home" to bring up the "Program" menu, or "F1-F4" to 

open the Task List and you decide not to access a different application, you 



can press "escape" ("Space-e" or "F4") to return to your previous location on 

the unit. 

You can use "F2-F3" to immediately cycle among all running programs 

without opening the Task List. This is similar to using "alt-tab" on your PC. If 

you are running three programs and are in the second program, pressing 

"F2" and "F3" moves you to the third program. If you press "F2-F3" again, 

you are placed in the first program. 

In the above case, if you were to press "Space-Z" to close the currently open 

program, you are then placed in the previous program. However, if there is 

only one program running, pressing "Space-Z" closes the program and 

places you in the "Program" menu.  

 

2.9 Locking the Keys  

You can lock the keys on the Braille eMotion 40 to prevent the accidental 

pressing of keys. To do this, long press the “Home key”. 

Braille eMotion 40 announces, "all keys locked". This means all keys on the 

unit are disabled including the on/off switch.  

To unlock the keyboard, long press the “Home” key once more, and the unit 

returns to normal operation. 

 

2.10 One-Handed Mode 

Braille eMotion 40 provides a One-handed mode for users restricted to the 

use of one hand for Braille input. To toggle One-handed mode on/off, press 

“Backspace-1-2-3”. You can also turn One-handed mode on or off in the 

"Global Options" dialog. 

When One-handed mode is on, use the following methods to input text:  



1. To type a character, press the dots in any combination or order. When you 

have pressed all dots, press "Space" to complete the entry of the character. 

For example, if you want to type "h," you press "dot 1" and "dot 2" separately 

or together and then press "dot 5." Finally, press "Space". 

2. To press a command that includes "Space," press "Space" both before 

and after the dot combination. For example, to press "Space-o (dots 1-3-5)," 

press "Space" then press "dot 1", "dot 3" and "dot 5" separately or together 

in any order. Then press "Space" again. 

3. To press a command that includes "Backspace" or "Enter," press 

"Backspace" or "Enter" before the dot combination. Then press keys that 

make up the dot combination. Finally press "Space". For example, to press 

"Enter-l (dots 1-2-3)", press "Enter", and then press "dots 1-2-3." then, press 

"Space". 

4. To press "Space," "Backspace" and "Enter", press the key twice. For 

example, to press "Space" to create a space between words, press "Space" 

twice. 

The operation of the scroll keys, function keys, and media buttons remains 

the same as in normal mode.  

If One-handed mode is on, the Braille eMotion 40 announces this each time 

it is powered on, as well as how to return to normal operation.  

 

2.11 Using Typing Mode 

While you are typing in a document, you may wish to turn off the navigation 

keystrokes, especially if you type very fast, as you may accidentally navigate 

when you intend to enter text. To turn on "Typing Mode", press "Backspace-

Space-Enter” " from within a document. "Start typing mode" is announced 

and displayed. 



When using "Typing Mode", if you press "Space-dot 4", instead of moving to 

the next line, the "Space" and "Dot 4" are entered into the document. 

To cancel "Typing Mode", Press "Backspace-Space-Enter” " once again. 

"End typing mode" is announced and displayed. After "Typing Mode" is 

canceled, navigation commands return to normal operation.  

 

2.12 Special Boot Sequences 

Braille emotion offers several hot keys for booting the unit under specific 

conditions, for example, in or out of One-Handed Mode, or booting with 

speech muted. Each of these sequences should be initiated from a complete 

Power Off state, they will not work when awakening the unit from Sleep mode. 

If you hold the “F1” key while powering on the device, it will boot in a muted 

state. Holding “F2” while powering on will boot in an unmuted state. 

Holding “F3” while powering on will boot the device in One-Handed Mode. 

Holding “F4” while powering on will boot with One-Handed Mode turned off. 

Hold the “Home” button while powering on the device to initialize all Braille 

eMotion 40 options back to their factory settings. Hold “F3-F4” while 

powering on to format the internal flashdisk. 

 

3. Customizing your Braille display 
When you receive your Braille display, one of the first things you will want to 

do is to configure it to act the way you want it to. The " Settings" menu allows 

you to configure and customize your Braille display to meet your specific 

needs and preferences.  

To open the "Settings" menu, press "Home" to bring up the main menu. Press 

"Space-4" until you reach "Settings" and press "Enter". Or, just press S from 

the main menu to quickly jump to and open the "Settings" menu. 



The "Settings" menu contains the following items: “Braille Options”, “Voice 

Options”, “Global options”, "Set Time and Date", "Setup Internet", "Bluetooth 

Manager", "Backup/Restore Braille eMotion Settings", and “Initialize Braille 

eMotion Options". The following sections discuss each of these items in 

detail. 

When in a settings dialog, You can toggle an option on or off or cycle through 

the available values of a setting with the "space" and "Backspace" keys. To 

save your changes, press "Enter" or tab to the "Confirm" button and press 

"Enter". Braille eMotion 40 says, "Saved options," and you are returned to 

your previous position on the Braille display. To cancel without saving 

changes, press the "F4" key, "Space-E" or "Space-Z".  

Many of the various Options in these menus also have global hotkeys, 

allowing you to adjust these settings from anywhere on the unit.  

 

3.1 Braille Options 

The "Braille Options" dialog contains the following settings. For each setting, 

the shortcut key appears in parentheses, and the global hotkey, if available, 

is shown in quotes.  

1) Braille display: (B). "Backspace-F3". Toggles the Braille display On/Off. 

2) Braille Cursor: (C). "F4-Up Scroll". Defines how the Braille cursor 

appears on the Braille display: "Always Up", "Blinking" or "Off". Note 

the cursor appears as dots-7-8 in most situations. When selecting text, 

it notes the end of the selection with blinking dots-1-2-3-4-5-6-7-8. 

3)  Eight Dot Mode: (E). "F1-Down Scroll". Toggles Eight Dot Mode on/off 

for ASCII text entry. 

4) View/input Braille Grade: (G). "Space-G". Lets you choose what grade 

of Braille you want to use when viewing/entering text: Uncontracted 

Braille, Contracted Braille, or Computer Braille. 



5) Use Computer Braille Input: (I). “F2-F3-X”. Allows you to switch to 

computer Braille input regardless of what the View Grade is set to. 

6) Braille Code: (C). "Backspace-Enter-B". Defines the rules by which 

Braille is translated to text and vice versa: "US", "UK", "UEB", or one 

of several foreign language Braille codes. When foreign language 

codes are set, you can read and write Braille according to that 

language's Braille rules. The Braille language also affects lists, combo 

boxes, and edit boxes. Prompts, menus, buttons and static boxes 

remain in English. 

7) Message Display Time: (M). defines how the Braille eMotion 40 deals 

with system messages: ignore, stand by until you press a key, or, 

display for from 1 to 10 seconds before disappearing. 

 

3.2 Voice options 

The "Voice Options" dialog contains the following settings. For each setting, 

the shortcut key appears in parentheses, and the global hotkey, if available, 

is shown in quotes.  

1) Voice: (V). "Backspace-F2". Toggles the voice output On/Off. 

2) Voice Volume: (L). "Backspace-F1 and Backspace-F4". Raises or 

lowers the volume of the text-to-speech. 

3) Voice Rate: (R). "Space-F1 and Space-F4". Controls the rate of the 

speech. 

4) Voice Pitch: (T). "Enter-F1 and Enter-F4". Adjusts the pitch of the 

Braille eMotion 40 voice. 

5) Punctuation Level: (P). Use this setting to choose how you want the 

Braille eMotion 40 to read punctuation marks and symbols: "All", "Off", 

"Punctuation," or "Symbols". 



6) Keyboard Echo: (K). Defines how Braille eMotion 40 speaks as you 

type: "On with characters and words," "On with characters," "On with 

words," or "Off". 

7) Capitalization alert: (U). Choose how the Braille eMotion 40 alerts you 

that a character is capitalized, either when typing or when navigating a 

document or edit box by character: "Off", "Say cap," or "Pitch". 

8) Numbers: (N). Defines how Braille eMotion 40 speaks numbers: when 

set to "On", Braille eMotion 40 speaks numbers, and when set to "Off", 

it speaks digits. 

9) Use secondary Voice: (V). determines wheter text in mixed languages 

will use a secondary language voice during continuous reading. 

10) Voice Name: (V). Use this option to choose the personality of the 

reading voice. 

 

To install additional voices, press “F3” from the Settings list, and press “Enter” 

on the “Install Voice” button. You are placed in a list of Vocalizer voices that 

can be installed on the Braille eMotion 40. Use “Space-1” and “Space-4” to 

navigate the list, and press “Enter” to install the current voice.  

To install multiple voices at once, from the voices list, press “Space” on each 

of the voices you wish to install to select them, and press “Enter” to install all 

selected voices. 

 

3.3 Global Options 

1) Main Volume: (V). "Backspace-SPACE-F1 and Backspace-Space-F4", 

or the Volume Up and Down buttons. Controls the master volume of 

the unit, including system sounds, audio and speech. 

2) Scroll Voice: (S). Choose whether you want the Braille eMotion 40 to 

speak while using the scroll buttons as you read. 



3) System Alerts: (A). Choose whether the Braille eMotion 40 alerts you 

to various events using audio signals, vibration signals, both, or no 

signal. 

4) Battery Alerts: (B). Choose how you are alerted when your battery is 

low: "Message", "Beep", "Final Message" or "Final Beep". 

5) Play Power On/Off Sound: (P). Choose whether you hear a sound 

when you turn on/off the Braille eMotion 40. 

6) Scroll Buttons: (L). Defines the operation of the scroll buttons: "Scroll 

display", "Move by line", "Move by character", "Move by paragraph" 

and "Move by sentence". 

7) Skip Empty Lines: (E). Choose to have the Braille eMotion 40 alert you 

to a blank line by announcing "Blank" or skip empty lines. 

8) Control Information: (I). Define where information is announced 

regarding the type of control on which you are currently located, a list 

item, menu, combo box, etc. Choose from Before, After and Off. 

9) Hide passwords: (P). Choose whether the characters of a password 

are hidden as you type them. 

10) Hot Key Information: (H). Defines how hot key information is 

announced: "Letters," "Dot patterns," or "Off". 

11) Announce shortcut keys: (S). Lets you choose whether the 

Braille eMotion 40 speaks the menu shortcut key for a function as you 

encounter it. 

12) power Button operation: (P) “Backspace-Enter-P”. Choose the 

state your Braille eMotion 40 goes in to when the Power button is 

pressed: “Screen Off”, as in the case of a normal Android phone or 

tablet, or “Deep Sleep”, which turns off Bluetooth, Wi-fi, etc., similar to 

a traditional Braille display sleep mode. 

13) Sleep Mode: (P). Set Braille eMotion 40 to save power by 

automatically shutting down after a certain period of time: "On", "Off", 

or "Message". (Only active when using battery power.) 



14) Sleep Mode Kick In: (K). Use this option to set the time of 

inactivity before entering SLEEP Mode: 10 minutes, 40 minutes, or 30 

minutes. 

15) One-Handed Mode: (H). This option allows users with only the 

use of one hand to use the Braille eMotion 40 in a specific mode 

adapted for that purpose. For detailed information about one-handed 

mode, refer to section 2.10. 

16) Default notepad Document Type: (Q). Set the default document 

type for new documents you create using the Notepad: “DOCX 

document”, "Sense document", "Braille document,", "DOC document" 

or "Text document". 

17) Automatically synchronize with time server: (T). Using this 

feature, you can ensure the accuracy of the time on the Braille eMotion 

40 by synchronizing with an atomic clock when Braille eMotion 40 is 

connected to the Internet. 

18) Time Announcement: (T). Set the Braille eMotion 40 to announce 

the time every 5 minutes, every 10 minutes, 30 minutes or every hour. 

19) Progress indicator: (P). Defines how the progress of tasks like 

opening a document or copying files is indicated: "Silent," (no progress 

indication) "Beep," (continuous beeps while the task is performed) and 

"Message" (progress is shown as a percentage). 

20) Language: (L). Allows you to easily change the system language 

of the unit to any open firmware localization. *Several things to note: 

Currently Braille and TTS need to be changed separately via their 

respective options. Additionally, any open applications need to be 

closed and re-opened before they will appear in the changed language. 

 

3.4 Set Time and Date 

To set the Braille eMotion's internal clock, press "Enter" on "Set Time and 

Date" in the "Settings" menu. Or press T to open the "set time and date" 



dialog from the menu. You can launch the "Set Time and Date" dialog from 

anywhere on the unit by pressing "F3-T".  

The set time and date is a dialog, consisting of the following: "Time zone", 

"Time format", "Time", "Date Format", "Date", "Synchronize with time server", 

a "Confirm" button, and a "Cancel" button. You can move among these items 

by pressing “F3” or “Space-F3”. 

When you activate "Set Time and Date", "Time zone?" appears followed by 

the default time zone. You can choose your desired time zone by navigating 

to it using "Space-1" or "Space-4" or by typing the first letter of the time zone. 

Once done, move to the next item using "F3". 

The next item is "Time format", the options for which are 12 hour and 24 hour 

time. You can toggle between the two using "Space-1" or "Space-4".  

The next item is "Time". When typing the time, separate the hour and minute 

using a space or a colon.  

If you select 12 hour clock in the "Time format", A.M. or P.M. is displayed 

after the hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. 

by pressing "Space-X".  

Tab to "Date format". You can choose to display the date in either the "short" 

or "long" format. The short format displays the date numerically, while the 

long format displays the Month spelled out and shows the date as it would 

appear in literary form. Toggle between the two using "Space-1" and "Space-

4".  

The next item is "Date". Type the "Date" month, date, and year as 

mm/dd/yyyy. Use 2 digits for the month, 2 digits for the day, and 4 digits for 

the year, separating them by a space or a slash.  

The next item is "Synchronize with time server", used to synchronize time 

and date with a time server on the Internet. This function is extremely useful 

when the date and time of Braille eMotion 40 is faster or slower than the 



current time. To execute this function, your Braille eMotion 40 must be 

connected to the Internet. When connected, press "Enter" on the 

"Synchronize with time server" button. After synchronization, it displays the 

synchronized time in the "Time" edit combo box. The synchronized date is 

also displayed in the "Date" edit combo box. 

If you do not wish to enter date and time information directly, you can 

navigate using the following commands: 

When setting time: 

Move forward 1 hour: Space-4 

Move back 1 hour: Space-1 

Move forward 10 minutes: Space-5 

Move back 10 minutes: Space-2 

Move forward 1 minute: Space-6 

Move back 1 minute: Space-3 

When setting date: 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

When you have completed entering all of the information, press "Enter" to 

save your settings, or "Tab to "Confirm" and press "Enter", and you are 

returned to the "Settings" menu. 



 

3.5 Setup Internet 

The "Setup internet" function is used to configure your Braille eMotion 40 to 

use a Wireless connection to access the Internet.  

To activate "Setup internet", press "Enter" on "Setup internet" in the 

"Settings" menu, or press "I". You can open the "Setup Internet" menu from 

anywhere on the unit by pressing "F3-I" or by long pressing the “Wi-fi” key 

on the upper left of the keyboard.  

 

3.5.1 SETUP WIRELESS LAN 

Before setting up a Wireless LAN connection, be sure wireless is turned on. 

You can toggle wireless on and off from anywhere on the Braille eMotion 40 

by short pressing the “Wi-fi” key. In addition, when you choose this option, if 

Wireless is not turned on, Braille eMotion 40 automatically activates Wireless 

LAN.  

The "Wireless LAN" dialog consists of the "access points" list, "Advanced" 

button, "Options" button and "Close" button. You can move among these 

controls by pressing "F3" or "Space-F3". If wireless is not turned on, the 

"access points" list displays "no items".  

When wireless is on, this list shows the wireless "access points" (networks) 

in range of your Braille display. The "Access points" list displays the "access 

point name", "encryption", and "sensitivity" of each item. (Ex: linksys, 

encryption: WEP, sensitivity: good.) If there is more than one access point in 

the list, you can move among them by pressing "Space-1" or "Space-4". 

Move to the "access point" to which you want to connect, and press "Enter". 

If the access point has no encryption, the Braille eMotion 40 announces, 

"Connecting to (access point name)". If connection is successful, the 

connecting sound is heard. If the network is encrypted and requires a 



network key, when you press "Enter" on the access point, the "Network key" 

edit box is displayed. Type the network key in computer Braille in the edit box 

and press "Enter". If your settings are correct, the unit says, "Completed 

setting profile" and the connecting sound is heard.  

The "Advanced" dialog is used to modify an existing profile, manually add a 

new profile, or check the settings of an existing profile. Pressing "Enter" on 

the "advanced" button, while wireless LAN is turned on, displays a list of the 

wireless profiles saved on the Braille eMotion 40. 

The "Advanced" dialog has 6 controls: the "profile list", "Connect" button, 

"Add" common dialog button, "Remove" button, "Properties" common dialog 

button, and "Close" button. You can navigate among these controls by 

pressing "F3" or "Space-F3". Navigate the items in the Profile list using 

"Space-1" and "space-4". Press "Enter" to activate one of the buttons. 

Use the "Add" button: to manually add a profile, specifically where an SSID 

is hidden, and thus does not appear in the "access points" list. The "Add" 

dialog" contains 6 controls. 

1) "Network name (SSID)" computer edit box: Type the network ID in the 

computer edit box. 

2) security, Use Space to choose among the security types for your network. 

3) As most networks do have some security, the next item in the tab order 

will likely be “password”. This will not appear if you choose “None”, or 

“Enhanced Open”. Please enter the password in computer braille, and Tab 

to the next item. 

4) The next item is a check box allowing you to decide whether to access 

additional advanced options. If you check this, the following will appear in 

the tab order: 

 A) Proxy: the options for which are “Detect Automatically”, “Metered” 

and “Unmetered”. 



 B) Proxy: the options for which are “None”, “Manual” and “Auto-

Config”. 

 C) Proxy Host name: A computer edit box in which you should type 

this. 

 D) Proxy Host Port: Another computer edit box in to which you should 

enter the information. 

 E) Bypass Proxy for: Enter the relevant info in to the computer edit 

box. 

 F) IP Settings: Use Space to choose between DHCP or Static. 

Choose Static if you need to set a specific IP address for your device. 

 G) Privacy: a combo box from which you can choose between “Use 

randomized MAC” or “Use device MAC”. If you are connecting to a school 

network or other professional network that requires your device to be 

identified by its Mac address, you should choose “Use device MAC”. 

 H) Hidden network: A Yes/No combo box with which you identify 

whether the network is visible or not. 

5) Confirm Button: Press Enter on this button to save your settings. 

6) "Cancel" button: You can select this button to cancel the setup. 

To delete a profile item in the profile list, select the profile item you wish to 

delete, and press R or "Tab" to the "Remove" button and press "Enter".  

To get information about a selected profile item in the profile list, "Tab" to the 

"Properties" button and press "Enter". In the "Properties" dialog, you can 

reconfirm or modify the information for each profile.  

To exit the "Advance" dialog, press "Space-E" or "Space-Z". 

The "Options" dialog allows you to set  



how the Braille eMotion 40 scans for and detects wireless networks. Use 

"Space" to adjust the options in the dialog, and press "Enter" to save your 

settings. 

The first option lets you choose whether Wi-fi is turned on automatically. The 

second option allows you to choose whether you receive notifications when 

networks are available. 

 

3.6 Bluetooth Manager 

The Braille eMotion 40 is Bluetooth capable, or rather, you can connect the 

Braille eMotion 40 to various devices such as keyboards, printers, audio 

devices, and other computers without the need for cables. You can also use 

Bluetooth to transfer files, or to connect the Braille eMotion 40 as a Braille 

display with a compatible screen reader. Bluetooth is the latest in wireless 

technology and enables wireless connectivity via a Personal Area Network 

(PAN). Unlike a traditional Wireless Local Area Network (WLAN), these 

networks are limited to approximately 30 feet or less. Bluetooth enables 

users to exchange various types of information over this wireless connection.  

You can toggle Bluetooth on/off from anywhere on the unit by pressing the 

“Bluetooth” key on the upper left of the keyboard. 

To access the Bluetooth Manager from the program menu, navigate to the 

"Settings" menu, and press "Enter. Then, navigate to "Bluetooth Manager", 

and press "Enter". You can also press "F3-B" to launch the Bluetooth 

Manager from anywhere on the unit. 

 

3.6.1 BLUETOOTH DEVICE LIST 

When the Bluetooth Manager is activated, you are placed in a dialog with 2 

items: a paired devices list, and a "Search" button to scan for available 

devices. For example, if you have a computer with Bluetooth enabled nearby, 



the Braille eMotion 40 attempts to find it. It may take 30 to 40 seconds to 

discover all of the Bluetooth devices in range. The Braille eMotion 40 

announces and displays, "Scanning for devices. Please wait...” Full cells are 

filled in on the Braille display to indicate scanning progress.  

When a Bluetooth device is detected, the Braille eMotion 40 announces 

"found (Bluetooth device name)".  

⚫ Note: while the Braille eMotion 40 is scanning for Bluetooth devices, 

it cannot respond to key presses. In addition, you may not cancel the 

scan once it has begun, but must wait for its completion before the 

Braille eMotion 40 returns to normal operation.  

When the scanning process completes, you are placed in the Bluetooth 

Device List. If the Braille eMotion 40 has found other Bluetooth devices in 

range, they are displayed as "device name (untrusted (or trusted)) xx/yy" 

where xx is the number at which the device appears in the list, and yy is the 

total number of devices. "Trusted" indicates that the service has been 

authenticated, "untrusted" indicates the service has not been authenticated. 

If there are no other Bluetooth devices in range, the Braille eMotion 40 

announces, "no items". You can press "Space-1" or "Space-4" to move 

through the list. To select a device from the list, press "Enter" on the device 

name. 

If the Bluetooth device is trusted, settings for connecting the device are 

automatically saved in the Braille eMotion 40. If you want to delete this 

information, press "Space-D" on the Bluetooth device name in the list. The 

Braille eMotion 40 announces, "Device settings removed". Removal of the 

settings applies only to the current device. 

From the Bluetooth Device List, you can access the menu by pressing "F2". 

The "Bluetooth Device List menu" contains "Rescan for Devices", "Delete 

Pair Information", "Options" and "Exit". You can navigate among the menu 

items using "Space-1" or "Space-4". 



The first menu item is "Rescan for Device". This option initiates a new scan 

for other Bluetooth devices. To activate this item, press "Enter" on "Rescan 

for Devices" in the menu. Or you can activate it directly from the list by 

pressing "Enter-R".  

The next menu item is "Delete Pair Information". This item allows you to 

remove the connection settings for the current device. To activate this item, 

press "Enter" on "Delete Pair Information" from the menu, or press “Space-

D" to activate it from the Device List.  

The "Options" item lets you determine if the Braille eMotion 40  is 

discoverable to other Bluetooth devices. Press "Space" to check or uncheck 

the option. 

The final item in the Bluetooth Device List menu is "Exit". This option exits 

the Bluetooth Manager program. To activate this item, press "Enter" on "Exit" 

from within the menu, or exit the program any time by pressing "Space-Z".  

 

3.6.2 BLUETOOTH SERVICE LIST 

When you locate a Bluetooth device to which you'd like to connect, press 

"Space-1" or "Space-4" to navigate to the device in the Bluetooth Device List, 

and press "Enter" on the device name. The unit announces, "Scanning for 

services. Please wait...” Please note The Braille eMotion 40 does not 

respond to key presses during the scanning process.  

The Braille eMotion 40 supports the following Bluetooth services: FTP, Serial 

port, USB port, and headset. To access any of these functions, be sure that 

the remote Bluetooth device is in Discoverable mode, and that the service 

you wish to access is enabled on that device. It is possible to have certain 

services enabled on your remote Bluetooth device, while disabling others. 

The Braille eMotion 40 only sees and displays services which are enabled 

on your remote device, even if others are available.  



When the Braille eMotion 40 has found all of the available services, the 

services are displayed in a list in the following format: "service name xx/yy" 

where xx is the number at which the service appears in the list, and yy is the 

total number of available services. You can move through the available 

services by pressing "Space-1" or "Space-4". Press "Backspace" to return to 

the Bluetooth Device List. 

From the Bluetooth Service List, you can access the menu by pressing 

"Space-M" or by pressing "F2". The "Bluetooth Service List menu" contains 

"Open FTP", "Disconnect" and "Exit". You can navigate the menu items using 

"Space-1" or "Space-4". 

The "Open FTP" menu item allows you to quickly open a direct FTP 

connection with a remote Bluetooth device without accessing the Device and 

Service lists. However, you must have connected the FTP service previously 

for the Braille eMotion 40 to allow you to transfer files. If you have not 

connected the FTP service, and you activate this function, the unit 

announces, "FTP service disconnected".  

You can access "Open FTP” by pressing "Enter" on it from within the menu, 

or by pressing "Enter-T" directly from the Bluetooth Service List. The Braille 

eMotion 40 says, "Connecting service". Detailed information on connecting 

various service types is covered later in this chapter. 

The "Disconnect" menu item allows you to disconnect services with other 

Bluetooth devices. You can access this item by pressing "Enter" on 

"disconnect" from within the menu. Or you can activate it directly from the 

Bluetooth Service List by pressing "Enter-D".  

If there are no services connected and you activate this function, the unit 

says, "There is no service connected". 

 



3.6.2.1 Connecting a Service 

To authenticate a service and connect to it, press "Enter" on the service. The 

Braille eMotion 40 announces, "Connecting service". You are then prompted 

for a "PIN code:" You must use ASCII characters when you type the pin code. 

This edit box only appears when you have not previously connected to a 

service, and a pin code is required by the device. You can exit the edit box 

or delete text you have typed by pressing "Space-Z" and you are returned to 

the Bluetooth Service List. 

When you finish typing the pin code, press "Enter". The unit announces, 

"Please wait for authentication". If the remote device is setup correctly, and 

has not been set up to allow this device to always connect, the remote device 

also asks for a pin code. Please be sure to enter the same pin code on both 

devices. If the remote Bluetooth device pin code matches the pin code on 

the Braille eMotion 40, the service should authenticate. If connection is 

successful, the unit announces, "PIN code authentication accepted".  

You are then prompted, "Please wait. Access permission". If the remote 

Bluetooth device does not give access permission, the unit says, 

"Connection failed", and you are returned to the Bluetooth Services List. If 

the remote Bluetooth device gives you access permission, the Braille 

eMotion 40 says "Connection succeeded". If the connection succeeds, 

"Connected" is displayed after the service in the Bluetooth Service List. 

Some services may be connected without inputting a pin code depending on 

the Remote Bluetooth device settings. 

 

3.7 Backup/Restore Braille eMotion Settings 

If you hard reset your Braille eMotion 40 or initialize the Braille eMotion 40 

Options, the main option settings and settings for each program are 

initialized to the default values. If you have created a backup of your settings, 

you can restore the option settings after the hard reset. 



You can run this utility by pressing K from the "Settings" menu. You can also 

launch the "Backup/Restore Braille eMotion Settings" dialog from anywhere 

on the unit by pressing "F3-K".  

The "backup/restore" dialog contains: the "program option check box list", a 

"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" 

button. You can move among the check boxes in the "program option check 

box list", by pressing "Space-1" or "Space-4". You can move among the 

controls in the dialog by pressing "F3" or "Space-F3". 

The "program option check box list" contains "Options settings", "File 

manager options", "Notepad options", "E-mail Options", "Media Player 

options", "Radio Options", "DAISY Player options", "Address manager 

options", "Schedule manager options", "Web browser options", “Excel 

Viewer Options", "Wake Up Alarm Options" and “Bluetooth manager options". 

In this list, move to the program options you want to backup or restore and 

check the item by pressing "Space". You can uncheck a checked item by 

pressing "Space" again. To select all of the program options in the list, press 

"Enter" on the "Select all" button.  

After selecting all the options you want to backup or restore, press "Enter" 

on the "Backup" or "Restore" button, or press "Enter-B" to backup or "Enter-

R" to restore. If you select the "Backup" button, you are prompted to select 

a path for storing the backup file. You can accept the default path, or choose 

an alternative. Navigate to the folder in which to store the backup files using 

normal file/folder navigation commands. Select the folder or drive in which to 

store the backup by pressing "Space", and press "Enter" to start the backup 

process. If you select the "Restore" button, you are prompted for the path 

from which to restore backup files. Again, use normal file and folder 

navigation to select the folder containing your backup files. If you select a 

folder in which there is no backup, you receive a message indicating there is 

no backup option file. To restore your settings, select the folder containing 



the backup files by pressing "Space", then press "Enter" to initiate the restore 

process. 

 

3.8 Initialize Braille eMotion Options 

You can use the "Initialize Braille eMotion Options" item to restore the Braille 

eMotion 40 to the factory default settings. *Note: this resets all option settings 

to their defaults, but does not erase your data. 

To launch this function, navigate to it in the "Settings" menu, and press 

"Enter", or press C.  

You are prompted, "Do you want to initialize options?" Use "Space" to choose 

"Yes" or "No". Choosing "Yes" initiates the factory reset process. Choosing 

"No" cancels the function and returns you to the "Settings" menu.  

You can also perform this function by holding the “Home” key while booting 

the Braille eMotion 40 from a complete shut down. 

 

4. File Management 
 

4.1 Overview 

The first 2 items in the main menu both relate to file management. The “My 

Documents” option displays the main folders of the internal flashdisk that are 

used by the Braille eMotion40 , for reading DAISY content, reading books 

and documents, and playing music. You can open the “My Documents” area 

by pressing “Enter” on it from the main menu, or by pressing the letter “Y”. 

The functionality and structure of the "File Manager" on the Braille eMotion 

40 are similar to "Windows Explorer" on a PC, and offer access to all files 

and folders on the flashdisk as well as any connected USB drive or SD card. 

To run the "File Manager", press F from the "Program" menu or press "Enter" 



when your cursor is placed on "File Manager". You can launch the "File 

Manager" from anywhere on the unit by pressing "F1-F". Close the "File 

Manager" or “My Documents” by pressing "Space-Z". 

With a few exceptions, the “My Documents” area and the full “File Manager” 

operate identically, other than the “My Documents” program offering a 

narrower scope of access to only those folders on the internal flashdisk 

automatically used by the Braille eMotion 40. Subsequent documentation in 

this chapter will refer to the “File Manager”, however, this term applies in 

general to both file management applications, unless otherwise specified. 

The ”My Documents” program opens in a list of common folders used by the 

internal programming of the Braille emotion, including “Books”, “DAISY”, 

“Documents” and “Music”. 

When you first open the "File Manager", you are placed in the drive list. By 

default, you are placed on the internal "flashdisk". If an SD card or USB drive 

is connected, it also appears in the list. You can use "Space-1" or "Space-4" 

or the scroll buttons to navigate the items in the drive list. Press "Enter" on 

the drive you want to open. The Braille eMotion 40 then displays the list of 

the files/folders on that drive.  

The "File Manager" contains both menus and hot keys, allowing you to easily 

activate items in the program with a single keystroke as well as to access 

functions through the menus for commands you have not memorized. You 

can bring up the menus by pressing "Space-M" or "F2". For the purposes of 

the directions in this chapter and the rest of this manual, we will use F2. 

However, either keystroke will perform this function. 

Use Space-1" and Space-4" to navigate among the available menus. To 

open a menu, press "Enter". Again, use "Space-1" or "Space-4" to navigate 

among the items in a menu, and press "Enter" to execute a menu item. 

The File Manager also contains dialogs. You can navigate among the 

controls in a dialog box by using the equivalents of "Tab" on a PC. You can 



use "F3" or "Space-4-5" for "Tab" and "Space-F3" or "Space-1-2" for "Shift-

Tab". For the purposes of instructions in this manual, we will use "F3" and 

Space-F3", or you will be directed to "Tab" or "Shift-Tab". 

 

4.1.1 NAVIGATING THE FILE LIST 

The "File Manager" contains two kinds of lists: the "file list" and the "menu 

list", or rather, the list of items contained in the "File Manager" menu. The 

menus in the Braille eMotion 40 wrap. This means, when you reach the end 

of the list of items in a menu, the Braille eMotion 40 automatically brings you 

back to the top of the list when you press "Space-4". However, when you 

reach the end of a "file list," the Braille eMotion 40 remains at the end of the 

list, even if you press "Space-4". The following is a list of the keystrokes used 

for navigating lists: 

⚫ Note: the following keystrokes can be used to navigate any list on the 

Braille eMotion 40. 

1. Move to previous item: (Space-1) or up scroll button 

2. Move to next item: (Space-4) or down scroll button 

3. Move to the beginning of a list: Space-1-2-3 

4. Move to the end of a list: Space-4-5-6 

The following keystrokes are valid only in a "file list". 

1. Jump to folder or file list: Space-5-6 

2. Move between file list and address window: (Space-4-5 or F3) / (Space-

1-2 or Space-F3) 

3. Enter the selected folder or open the selected file: Enter 

4. Move back a level in the folder structure: Backspace 

5. Jump to the drive list: Space-1-2-5-6 

6. Move to the previous group of 40 items: Page up (space 1-2-6 or F1-F2) 



7. Move to the next group of 40 items: Page down (space 3-4-5 or F3-F4) 

8. Jump to a file or folder by pressing the first character of the folder or file 

name. You must use ASCII characters. 

 

4.1.2 SELECTING FOLDERS AND FILES 

1. Select individual items "Space": * is displayed in front of the item to denote 

its selection. Pressing "Space" again on the selected folder or file cancels 

the selection. 

2. Continuous selection "Enter-b": This selects all of the items from the point 

where this command is executed to the item where the cursor is located. * 

appears in front of the selected items. 

3. Select all "Enter-a": This selects all the files and folders in the current list. 

You can toggle selection and de-selection of items by pressing "Space". 

When the "Select All" command is executed, the Braille eMotion 40 says the 

number of selected files, and * appears in front of the selected files on the 

Braille display.  

 

4.2 Working with Files and Folders 

When viewing the contents of a drive or folder, the items in quotation marks 

are folders, and the items without quotation marks are files.  

The items in the list are followed by numbers, such as 1/5 or 2/5. The 

numbers following the items indicate an item's placement in the list and the 

total number of items in the list. For example, "database 1/5," indicates 

"database" is the first folder in a list containing five items. 

 

4.2.1 ENTERING AND EXITING FOLDERS 

There are several ways to open a folder.  



1. Bring up the menu by pressing "F2". Select the "Open" option from the list 

and press "Enter".  

2. Press the hot key "Enter-O" to activate the "Open" command and open 

the desired folder. 

3. Finally, as described above, you can simply press "Enter" on the selected 

folder. 

To exit the current folder, use the "Backspace" key. You are returned to the 

previous level in the folder structure.  

 

4.2.2 EJECTING USB DRIVES AND SD CARDS 

*Note: this section applies specifically and only to the “File Manager” 

application. 

The Android operating system requires that drives are ejected properly 

before removing them. If not done, re-inserting them in to the Braille eMotion 

40 or connecting to other mobile devices or computers may result in all files 

appearing as though they have no data, or have a size of 0 bytes. Before 

disconnecting a USB drive or SD card, press “Backspace-Enter-U” or 

“Backspace-Enter-3-6” to    it from the system. If your drive is 

showing files with no data, please re-insert it in to the Braille eMotion 40, and 

press the Unmount key to eject it properly, and the data should, be visible 

once again. 

 

 

4.3 The File Menu 

To open the "File" menu, press "F2" to bring up the menu, and press "Enter" 

on "File". Use normal list commands to navigate to your desired option and 

press "Enter". 



The Braille eMotion 40 supports the following file formats:  

1. Document files: hbl, brl, txt, brf, rtf, doc/docx, PDF and unprotected EPUB. 

2. Web formats: html.  

3. Media formats: ac3, asf, asx, m3u, mp2, mp3, MP4, ogg, pls, wav, wax, 

wma, wmv and flac.  

4. DAISY formats: DAISY 2.0, 3.0, BookShare.  

 

The menu contains the following items. Shortcuts are placed in parentheses, 

and hotkeys are in quotes. 

1) Open: (O) "Enter-O". Opens the selected file in the associated application 

for its file type.  

2) Open in Document Reader: (K) “Backspace-R”. Appears only for 

supported document types, allowing you to open the file in the Read only 

Document reader as opposed to  the default Notepad or Notepad. 

3) Open in second Notepad: (W) “Backspace-O”. Allows you to open 

compatible documents in a second version of the Notepad for easier 

switching between 2 files. Appears only when compatible documents are 

displayed. 

4) Open With: (E) "Enter-E". Allows you to choose a compatible application 

with which to open the selected file. 

5) Zip (Z) "Enter-Z". Compresses the current file or folder. 

6) Unzip (U) "Enter-U". Appears only for compressed files, extracts the 

current file.  

7) Send To: (S) "Enter-S". Lets you send the current file or folder to a different 

location. Targets include any connected local drives, e-mail, and “Android 

Program, which will allow you to send files to available 3rd party apps 

according to the file type you are sending. 



8) Rename (R) "Enter-R". Rename the current file or folder. 

9) New Document: (N) "Enter-N". Create a new document using DOCX, DOC, 

TXT, BRL, or HBL. 

10) New Folder: (F) "Enter-F". Creates a new folder. 

11) File Conversion: (T) "Enter-T". Converts selected document files to TXT, 

BRL, or HBL. 

12) Find File: (F) "Space-F". Search the current drive or folder for a specific 

file by name. 

13) Find Text: (F) "Backspace-F". Search Word, Text, and Braille files on the 

current drive or folder for specific text strings.  

14) Merge Files: (M) "Enter-M". Select 2 or more text or Braille files to merge 

together. 

15) Split Files: (P) "Enter-P". Split text or Braille files by paragraph or word 

count, by size, or into a certain number of files of equal size.  

16) Information: (I) "Enter-I". Provides basic properties of the current file or 

folder. 

17) Exit: (Z) "Space-Z". Closes the File Manager. 

  

4.4 The Edit Menu 

The Edit Menu contains the following items: 

1) Copy: (C) "Enter-C". Copies the selected files or folders to the clipboard. 

2) Cut: (X) "Enter-X". Cuts the selected files or folders to the clipboard.  

3) Paste: (V) "Enter-V". Pastes the files or folders on the clipboard to the 

current location. 

4) Delete: (D) "Space-D". Deletes the selected files or folders. 

5) Select All: (A) "Enter-A". Selects all the files and folders in the current list. 



 

4.5 The View Menu 

The View Menu contains the following options: 

1) Sort Files By: (G) "Enter-G". Determines in what order files and folders 

are displayed. 

2) Set File Info: (L) "Enter-L". Determines what information is displayed about 

each file or folder in the list.  

3) Display Only Files of Type: (W) "Enter-W". Filters files by file type. 

4) Hide System Folders: (H) "Enter-H". Hides Android system folders that do 

not contain user content. These are hidden by default. 

5) Set Start Folder: (S) “Backspace-S”. Lets you choose the location the File 

Manager opens to. 

6) Document Open Settings: (D) “Enter-D”. This setting lets you determine 

in which program DOC and DOCX files are opened by default, Notepad or 

Notepad. You can also choose to “Always select”, in which case you will be 

prompted every time. 

 

4.6 Using the Address Window 

*Note: this section applies specifically and only to the “File Manager” 

application. 

This edit box lets you type the direct path of the file name you want to open. 

This window also contains the history list for easily accessing recently 

opened files or directories.  

When you are in a file or folder list, you can press "tab (Space-4-5)" to 

navigate to the address window. The Braille eMotion 40 displays the current 

path including the current drive name, such as "flashdisk/download/". The 



address window is only visible when you are in a file or folder list. When you 

are in the drive list, the address window is not available. 

You can edit the text by relocating the cursor with a cursor routing key, the 

Braille eMotion 40 inserts the text at the cursor location. If you know the exact 

path and file name, you can type in the path and file name to open the file 

with the appropriate application. For example, if you type in 

"flashdisk/download" in the address window and press "Enter," the Braille 

eMotion 40 displays the list of the files in the download folder. If you type 

"flashdisk/My Documents/sample.txt" in the address window, and press 

"Enter," the Braille eMotion 40 loads the Notepad, and opens the file 

"sample.txt".  

Use "Space-1" or "Space-4" in the Address Window to review the history list 

(a list of file and folder paths you have recently opened). To open a file in the 

history list, press "Enter". The file opens with the appropriate application. 

(See section 4.2.3). 

 

5. Notepad 
The Braille eMotion 40 Notepad supports reading and creation of RTF, TXT, 

HBL, BRL and BRF files as well as unformatted DOCX files, and will open 

PDF, EPUB, DOCX and DOC files. To read PowerPoint files, or to create 

and/or preserve formatting in Word documents, or to create mathematical 

expressions, please use the Notepad described in the previous chapter.  

*Note: though you can open Word documents in the notepad, all document 

formatting will be stripped. Response time for navigation and searching will 

be reduced in the Notepad, but if a Word document is saved from within it, 

all formatting will be lost. 

You can launch the "Notepad" in a couple of ways: 



Press "F1" to open the main "Program" menu. Navigate to "notepad" using 

"Space-4" and press "Enter". You can also press N from the main menu to 

quickly jump to and open the "notepad”. 

You can launch the "Notepad" from anywhere on the unit by pressing "F1-N". 

When you launch the Notepad on the Braille eMotion 40, it places you in a 

new, blank document. You can activate all the functions of the Notepad via 

the Notepad menu or by using hot keys. The menu in the Notepad consists 

of File, Edit, insert, Go To, Read, and Layout. To access these menus, press 

"Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and 

press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut 

for the corresponding menu item.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 

"Space-F3" to tab among controls in a dialog.  

Press "Enter" to execute an item. 

 

5.1 File Menu 

The File menu contains the following options: 

1) New: (N). Creates a new document, by default named "noname". You can 

create a DOCX or DOC file without formatting, or a TXT, BRL or HBL file. 

2) Open New Notepad: (W) “Backspace-o”. Opens a second instance of the 

Notepad, so you can more easily switch between open files. 

3) Open: (O) "Enter-O". Opens an existing file. Supported file types include 

all those listed at the beginning of this chapter. 

4) Recent File list: (R “Backspace-Enter-H”. Displays files you’ve recently 

opened in the Notepad. 



5) Opened Documents List: (D) “Backspace-Enter-O”. Displays all the 

currently opened documents in a list, so that you do not have to Tab and 

Shift-Tab through all of them. 

6) Save: (S) "Enter-S". Save the current file. Tab between name, location and 

file type. Use normal file management navigation to choose a different folder.  

7) Save As: (A) "Space-S". Save the current file under a different name, as 

a type or in a different location. You can choose to password protect files by 

choosing the HPF file format. 

8) Close Current document: (Q) “Space-Q”. Appears only if more than one 

document is currently open, and closes only the current file 

9) Print: (P) "Space-P". Supports only Braille embossing: the document will 

be printed using a connected embosser. 

10) Settings: (E) "Enter-E". Dialog to set various document options. Tab 

among settings list, location Info check boxes, Default folder, Set Password, 

and Confirm and Cancel buttons. Settings list includes View Format 

Characters, Reading unit for Space-1 and Space-4, Read Only On/Off, 

Automatic Save Interval, Auto Scroll Speed, Apply Settings to All Documents, 

Home/End movement unit, New Document default name and Show Right to 

Left Braille. Use “Space-1” and “Space-4” to move among the settings in the 

Settings list, and Space or Backspace to change the value of the setting. 

11) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary 

installed, and inserts the word under the cursor in the lookup edit box.  

12) Exit: (Z) "Space-Z". Closes the Notepad. 

* The Braille eMotion 40 allows you to encrypt and password protect files 

which you do not wish for anyone else to be able to open. Before you save 

a document as a protected file, you must set a password in the "Settings" 

option under the "File" menu. The "Set Password" dialog consists of 5 items: 

"Delete the original file" checkbox, ?, a "Password?" edit box, a "Retype 



Password" edit box, a "confirm" button, and a "cancel" button. Once the 

password is set, use the save as dialog, and choose HPF as your file type.  

 

 

5.2 Edit Menu 

The Edit Menu contains the following items: 

1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The 

end of the selection is marked by the current cursor position.  

2) Copy: (C) "Enter-C". Copies selected text to the clipboard. 

3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard. 

4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location. 

5) Delete: (D) "Space-D". Deletes selected text. 

6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the 

selected text area. 

7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard 

without deleting the prior selection. 

8) Clear clipboard: (E) "Enter-D". Empties the clipboard. 

9) Select All: (A) "Enter-A". Selects all the text in the document.  

10) Toggle Insert/overwrite Mode: (I) “Space-I”. determines whether, when 

you type text, if it is inserted at the current position, or overwrites the current 

text. 

11) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and 

begins checking the document for errors. Use “F3” and “Space-F3” to move 

among the controls, and “Space-1” and “Space-4” to move through lists of 

options. You can also use the following hot keys: 

 A. Skip Once: Backspace-S. 



 B. Skip All: Backspace-I. 

 C. Modify Current: Backspace-C. 

 D. Modify All: Backspace-M. 

 E. Add to User Dictionary: Backspace-A. 

You can also spellcheck the current word with “Backspace-K”. 

 

5.3 Insert Menu 

1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position. 

2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark. 

3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark. 

4) Insert from File: (I) "Enter-I". Inserts information from another file. 

5) Insert Date: (W) "Enter-W". Inserts the current date. 

6) Insert time: (T) "Backspace-W". Inserts the current time. 

7) Insert Page Break: (P) “Backspace-Space-Enter-P”. Inserts a form feed. 

8) Insert Tab: (T) “Backspace-Space-Enter-I”. Indents 5 spaces from current 

position. 

 

5.4 Go to Menu 

1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string 

to search, choose whether to match case, and choose the search direction.  

2) Find Next: (H) "Enter-F". Finds the next instance of the previously 

searched string. 

3) Find Previous: (V) "Backspace-F". Finds the previous instance of the 

search string from your current position. 



4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and 

replace with an alternative string. Choose search direction, match case, and 

whether to replace one instance, from cursor to end, or all. 

5) Go To Location: (L) "Enter-L". Go to a location in the document according 

to page, paragraph, line or percentage. 

6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence. 

7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence. 

8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page. 

9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page. 

10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are 

open, moves to the previous document in the order the files were opened. 

11) Go To Next Document: (N) "Tab". If multiple documents are opened, 

moves to the next document in the file open order.  

 

5.5 Read Menu 

1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text. 

2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a 

selected text block. 

3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the 

beginning of the document to the current cursor position. 

4) Read from Cursor to End: (Q) "Enter-G". Reads from the current cursor 

position to the end of the document. 

5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. 

Set the speed of the auto scroll in the Settings under the File menu.  

6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence. 

7) Read Current Line: (L) "Space-1-4". Reads the current line. 



8) Read Current Word: (W) "Space-2-5". Reads the current word. Press 

twice to spell. 

9) Read Current Character: (C) "Space-3-6". Reads the current character. 

Press twice to hear the military alphabet equivalent. 

10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position 

as page, paragraph, word, and line. 

11) Read Status: (S) "Space-3-4". Reads title of document and indicates 

Insert or Overwrite mode. 

12) Read Character Count: (I) "Backspace-I". Reads the current and total 

character count of the current document. 

 

5.6 Layout Menu 

1) Braille Paragraph Layout: (B) "Backspace-1-2-4-6". Determines the Braille 

format of the current paragraph. 

2) Braille Document Layout: (P) "Backspace-P". Determines Braille 

document format for embossing. 

 

 

  



6. Connectivity 
The "Connectivity" menu allows you to manage and move among 

the various Braille Display connections you have established with 

your Braille eMotion 40. To open the "Connectivity" menu, from the 

main menu, navigate to it with the arrow keys and press "Enter", or 

press the letter C. 

You can also open the “Connectivity” menu from anywhere by long 

pressing the “Connect” key on the top left of the keyboard. 

When you first open "Connectivity", you are asked if you want to 

establish a USB connection or Bluetooth connection. Use "Space-

1" and "Space-4" to make your choice and press "Enter". 

The final item in the Connectivity Menu is the “Pairing list”. Once 

you have established connections, you may re-activate them from 

this list, or by using shortcuts described later in this section. 

Braille eMotion 40 supports 1 USB and 5 Bluetooth connections.  

When in Terminal mode, you can switch among the established 

connections by pressing “Space” with the “Connect” key to move to 

the next connection in the Pairing list, and “Backspace” with the 

“Connect” key to move to the previous connection in the Pairing 

List. 

 

You can also interact with the various pairings using the Pairing list. Use 

the following key commands to perform their associated functions: 

• To open the pairing list, press the “connect” key. 

• Jump to a pairing by navigating to it and pressing Enter. 

• Press Space-D or the Backspace key to remove a connection from the 

Pairing List. 

• Press the Paring Key from the pairing list to disconnect the current 

connection without removing from the Pairing list. 



 

To close the Connectivity area and return to the Braille eMotion’s 

standalone programming, press Backspace-Space-Z (dots-1-3-5-6). 

You can also toggle between the stand alone programs and the 

Terminal by pressing “Space” with the “Input selector” key in the 

center of the Braille keys. 

 

6.1 Establishing a Connection  

If you choose "USB", you are directly placed in Terminal Mode. If you 

connect Braille eMotion 40 to a computer, it will automatically be 

recognized, however, no Braille output will occur automatically, unless a 

screen reader is running, the HIMS USB driver is installed, and the 

screen reader has been configured to use a HIMS Braille display.  

If you choose Bluetooth, Pairing Mode is initiated, and you must establish 

the Bluetooth pairing with your phone or PC. 

 

6.2 Supported Screen Readers 

The following screen readers have been tested and are known to 

be supported. However, any screen reader that offers support for 

the HIMS Braille EDGE should also support Braille eMotion 40. 

1)    Jaws (Freedom scientific) 

2)    Supernova (Dolphin) 

3)    System Access (Serotek) 

4)    NVDA (NV Access) 

5) Microsoft Narrator 

6)    Voice over for Mac and iOS (Apple) 

7)    BrailleBack for Android (Google) 



6.3 Connecting to a Screen reader 

 

6.3.1 CONNECTING TO PC VIA USB 

To connect the Braille eMotion 40 to a screen reader such as Jaws 

or NVDA via USB, you must install the proper USB driver on your 

PC. Below are steps for installing the USB driver.  

1) Download the USB driver for Braille eMotion 40  from the HIMS 

website. 

2) Unzip the compressed file and execute 

“Braille_SENSE_USB_Driver.exe. 

3) When the “Braille Sense USB Driver Setup wizard” appears, 

press the “Install” button. 

4) When the installation wizard appears, select the “Next” button. 

Continue this process until all drivers are installed. 

5) When the drivers are successfully installed, press the “Finish” 

button. 

6) Connect the Braille eMotion 40 to the PC via the USB cable, 

and “terminal mode” is displayed on the Braille eMotion 40. 

7) Windows will locate and automatically install the drivers.  

 When you have finished installation of the USB driver on the PC, 

please follow the instructions for connecting the display with your 

screen reader via USB. 

 

6.3.2 CONNECTING TO PC VIA BLUETOOTH SERIAL PORT 

The following steps will walk you through setting up the Braille eMotion 

40 to be used as a Terminal for Screen Reader (A Braille display). 

Before you begin, make sure that your Braille eMotion 40 is turned on 

and in pairing Mode. To enter pairing Mode, open the Connectivity 



menu, and choose Bluetooth Braille Connection. Braille eMotion 40 will 

display “Pairing Braille”.  

If you have already established a Bluetooth connection, you can long press 

the “Connect” key to re-open the “Connectivity” menu. 

be aware of your Braille eMotion’s designated Bluetooth name. 

1) Open the Control Panel. 

2) Open Devices and Printers 

3) Tab to “Add a Device” and press “Enter”. 

4) Windows searches for devices and displays them in a list. 

5) Use the Up or Down arrow to navigate to the Braille eMotion 40 and 

press “Enter”. 

6) If you are asked to enter the pass code for the device; enter 0000, and 

press “Enter”. 

7) The computer should display the message, "Found new hardware" and 

the final dialog should appear on the computer. The dialog should 

display that the Bluetooth device was successfully set up. It is very 

important to note the Bluetooth COM port when setting up the Braille 

connection, as you will need this when setting up your screen reader. 

 

6.3.3 USING THE BRAILLE EMOTION WITH JAWS FOR 
WINDOWS 

Use the following instructions to set up the Braille eMotion 40 as a 

Braille display with the JAWS screen reader from Freedom 

Scientific: 

1) Make sure Braille eMotion 40 is powered on, and in terminal 

Mode. If you are using USB, please connect the Braille eMotion 

40 to your computer via the included USB cable. 

2) Navigate to the JAWS Window and press “Alt” to open the 

menu. 

3) Press “Enter” on the “Options” menu 



4) Use the Up or Down arrow to navigate to “Braille” and press 

“Enter”. 

5) Choose HIMS Braille EDGE as your Braille device. 

6) Tab to “Advanced” and press “Enter”. 

7) Choose USB as the port if connecting via USB, or the correct 

Com Port if using Bluetooth. 

8) Tab to “OK” and press “Enter”. 

9) You are prompted that you must restart JAWS for the settings to 

take effect. Restart JAWS for Windows, and Braille should begin 

displaying. 

 

6.3.4 USING BRAILLE EMOTION AS A BRAILLE DISPLAY 
WITH NVDA 

Use the following instructions to set up the Braille eMotion 40 for use as a 

Braille display with the free NVDA screen reader from NV Access. 

1) Make sure Braille eMotion 40 is powered on, and in Terminal Mode. If 

you are using USB, please connect the Braille eMotion 40 to your 

computer via the included USB cable. 

2) Press “NVDA key-N” to open the NVDA menu. 

3) Arrow down to “Preferences” and press “Enter”. 

4) Arrow down to “Braille Settings” and press “Enter”. 

5) Choose “HIMS Braille Sense/Braille EDGE” from the Braille Display 

combo box. 

6) Tab to the “Port” combo box and ensure that it is set correctly. (NVDA 

employs automatic port detection, so you should not need to change 

this setting) 

7) Tab among the various combo boxes to choose options such as 

output and Input tables, cursor options, etc. Use the Up and Down 

arrows to navigate among the choices in each combo box. 

8) When you have finished choosing your settings, Tab to “OK” and 

press “Enter”. 

 



⚫ Note: Make sure the “Save configuration on Exit” box is checked in the 

NVDA menu in order to ensure your settings for the Braille eMotion are 

saved, thus the Braille eMotion 40 will automatically connect each time 

you use NVDA in the future. 

 

6.3.5 USING BRAILLE EMOTION WITH VOICEOVER ON THE 
MAC. 

 

To use the Braille eMotion 40 as a USB braille display with a Mac 

running VoiceOver, you can simply power on the Braille eMotion 

40, choose the USB connection from the Connectivity menu, and 

connect it to the Mac via USB. The unit is immediately recognized, 

and VoiceOver output is shown on the Braille display. 

Use the following steps to connect the Braille eMotion 40 as a Bluetooth 

Braille display with a Mac running VoiceOver when Braille eMotion 40 is 

in Bluetooth Connection Mode: 

1. Press Vo-F8 to open VoiceOver Utility. 

2. Navigate to “Categories” and press Vo-Shift-Down to begin 

interacting with it. 

3. Press B for Braille. 

4. Press Vo-Shift-Up to stop interacting with the Categories group. 

5. Press Vo-Right to “Display”, and press Vo-Space to activate it. 

6. Navigate to “Add”, and press VoSpace to activate. 

7. VoiceOver announces, “Searching for Bluetooth devices”. 

8. Navigate to the “Bluetooth devices” list and press Vo-Shift-Down 

to interact with the table. 

9. Navigate to “Braille EDGE” and press Vo-Shift-Up to stop 

interacting with the table. 



10. Navigate to “Remember this device” and press Vo-Space to 

check the box. 

11. Navigate to “select” and press Vo-Space” to activate it. 

12. VoiceOver asks for the pairing code and places you in the edit 

box. 

13. Type 0000 and press “Enter”. 

You should hear a chime indicating VoiceOver has connected to 

your Braille eMotion 40 and you should begin seeing VoiceOver 

output on the Braille display.  

 

6.3.7 USING THE BRAILLE EMOTION WITH IOS DEVICES 

Use the following instructions to connect the Braille eMotion 40 as a 

Bluetooth Braille display with your iPhone, iPad, or iPod, first ensuring 

Braille eMotion 40 is in Bluetooth connection Mode.  

Note: These instructions refer to the iPhone, however, they apply 

to all compatible i-devices: iPhone 3Gs and higher, iPad, and iPod 

Touch 3G and later. 

On the i-Phone: 

1) Navigate to Settings/General/Accessibility/VoiceOver/Braille. 

2) If Bluetooth is not activated on the I-Phone, it will prompt you to do 

this. WHEN Bluetooth is activated, the I-Phone searches for devices. 

3) The Braille eMotion 40 should appear in the list of available Braille 

devices under the name “BrailleEDGE. 

4) Double tap it in the Braille devices list. 

5) You should hear a chime on the iPhone, and the text displayed on the 

iPhone should appear on the Braille display of your Braille eMotion 

40. 

 



6.3.8 USING THE BRAILLE EMOTION WITH TALKBACK FOR 
ANDROID. 

Use the following steps to use your Braille eMotion 40 as a Braille 

display with TalkBack, first ensuring Braille eMotion 40 is in 

Bluetooth connection Mode. 

1) On your Android phone, swipe up and right to open the TalkBack 

menu. 

2) Swipe right until you reach “Braille Display Settings”, and double 

tap it. 

3) Ensure the “Use Braille Display” switch is set to on. If it is not, 

double tap it to change the status. 

4) Swipe right until you see your Braille eMotion 40 in the list, and 

double tap it. 

5) Navigate to the “Connect” button, and double tap it. 

6) You should hear a chime, and Braille should begin displaying 

from your Android phone on your Braille eMotion 40. 

 

6.4 Terminal Clipboard 

Terminal Clipboard allows you to create and edit text on the Braille 

eMotion 40 before sending it via the Terminal for Screen Reader to 

the connected device. This can be useful in instances like when 

using VoiceOver on an i-device, in which characters are translated 

as they are sent to the iPhone or iPad.  

Sometimes, creating/editing text when using a Braille display can be a 

tedious business. As explained above, the Terminal Clipboard 

allows you to create and edit text on the Braille eMotion 40 and 

send the completed text to the connected computer or Smartphone 

via the Terminal for Screen reader. 



To enter "Terminal Clipboard", press the “Input Selector” button in the 

center of the Braille keys. The Braille eMotion 40 displays "Terminal 

Clipboard", and places you in an edit box. Type and edit your text 

using normal text entry and edit commands. In "Terminal 

Clipboard", the Braille display and keyboard are temporarily 

disabled from sending/receiving information to/from your connected 

computer or i-device, so that you may use them for creating/editing 

your text.  

For more information on text entry and editing, please see section 3 of this 

manual on the Notepad. When you are finished typing the text you wish to 

send to your computer or smartphone, press "enter”, and the text is quickly 

inputted to the device via the Terminal for Screen reader, and your Braille 

eMotion 40 returns to sending/receiving information to and from the 

connected device. 

 

7 Document Reader 
The Document Reader allows you to open files in most supported text-based formats in a Read Only 

environment with special navigation features. In general, it allows you to read and interact with the 

elements of these files in a fashion similar to the DAISY Player, or a file opened in Read Only mode. 

The Document Reader supports the following file types: Txt, RTF, BRL, BRF, Doc, DOCX, PDF, EPUB, 

XML, HTM and HTML.  

You can activate all the functions of the Document Reader via the menu or by using hot keys. The 

menu consists of File, Edit, Go To, Read, and Mark. To access these menus, press "Space-M" or "F2".  

Select a menu item using "Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or 

"F2" followed by the shortcut for the corresponding menu item.  For example, to open the edit 

menu, press "Space-M" or "F2" to open the menu, and press E.   

The Document Reader also contains various lists and settings dialogs. Use "Space-1" and "Space-4" or 

the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-

2" or "F3" and "Space-F3" to tab among controls in a dialog.  

 



7.1 General Document Navigation 

When you first launch the Document Reader, by default, you are placed in the "Open" dialog. You 

can change the Document Reader's start position using the "Start Settings" described later. You can 

also access the Open File" dialog any time by selecting "Open" from the "File" menu, or pressing 

"Enter-O".   

You are placed in the list of folders and files in your "DOCUMENTS" folder. Use normal File and folder 

navigation to locate the file you want, and press "Enter". 

By default, when you press "Enter" to open a document, Braille eMotion 40 places you at the 

position at which you last exited the file. If you wish to have the document automatically start 

reading aloud, you can change this behavior in the "Voice Settings" described in section 7.2. 

You may navigate as the file reads aloud (continuous Reading Mode) or you may press "enter" to 

toggle to "Manual Mode" in which case, text is only read as you navigate to it, and only the selected 

element is read.  

In addition to the navigation keys described in the remaining sections of this chapter, you may use 

normal document navigation commands to read documents in the Document Reader as described in 

chapter 5 of this manual. 

 

7.2 The File menu 

1) Open: (O) "Enter-O". Brings up the "Open File" dialog from which you can open any of the 

supported file types listed above. 

2) Recent Documents: (R) "Enter-R". Shows documents recently opened in the Document Reader in a 

list. Press "Enter" on a document you want to read.  

3) Page Settings: (P) "Backspace-P". The page settings allow you to define how the document reader 

determines the amount of text to move by when navigating by page. The "Page Settings" dialog 

contains 4 items: an edit box in which you can "Set lines per page", edit box in which you can "Set 

characters per line", a "Confirm" button and a "Cancel" button.  

4) Voice Settings: (S) "Enter-S". The "Voice Settings" let you define how the document is read when 

using speech, including the ability not to use speech at all.  The "Voice Settings" list includes the 

following: Voice: (On/Off), Default Reading Mode: (Continuous or Manual), Set Volume, Set Speed 



and Set Pitch. You can also set your reading voice form among any of the Braille eMotion 40 

Vocalizer voices you have installed. 

5) Document Information: (I) "Enter-I". The "Document Information" option provides information on 

your current position in the document relative to the whole. The information includes the current 

and total page, paragraph, sentence and line, as well as the title of the document you are currently 

reading.  

6) Start Setting: (E) "Enter-E". The "Start setting" determines where you are placed when the 

Document Reader is launched. The options in the "Start Setting" combo box are "Open File dialog", 

"Recent Documents", and "No Startup Action", in which case, the unit simply lands on a blank 

screen, from which you can choose what function to perform. 

7) Exit with Bookmark: (Z) "Space-Z". Use this to close the "Document Reader and save the position 

in your current document. 

8) Exit and delete all marks: (Q) "Enter-Z". This option closes the Document Reader and deletes any 

existing marks in the current document. 

9) Exit without bookmark: (C) "Backspace-Z". This option closes the Document Reader, but does not 

save your position in the current document. 

 

7.3 The Edit Menu 

1) Start Selection: (B) "Enter-B". Allows you to select a certain portion of text that you would like to 

copy to the clipboard. The end point of the selected text is determined by the location at which you 

place the cursor after setting the start pointwith "Enter-B".  

2) Copy: (C) "Enter-C". After selecting text, activate "Copy" from the "Edit" menu, or press "Enter-C" 

while in a document.  

3) Add to Clipboard: (P) "Enter-P". To add selected text to the clipboard, select "Add to Clipboard" 

from the "Edit" menu, or press "Enter-P" while in a document.   

4) Clear Clipboard: (E) "Enter-D". To delete the text in the clipboard, select "Clear Clipboard" from 

the "Edit" menu, or press "Enter-D" while in a document.   

5) Select All: (A) "Enter-A". Selects all the text in your current document. 

 



7.4 The Go To Menu 

1) Find: (F) "Space-F". The find function allows you to search for text in a document. The Find dialog 

consists of "Text to find", "Search direction", "Match case", a "Confirm" button, and a "Cancel" 

button.  

2) Find Next: (H) "Enter-F". "Find Again" looks for additional instances of the text that was searched 

for in the previous "Find".  

3) Find Previous: (V) "Backspace-F". The "Find Previous" function works the same ways the 'Find 

Again" function described above, however, searches the document in the backward direction. 

4) Go to Location: (G) "Enter-L". The "Go to Location" command moves quickly to a specific page, 

paragraph, or line.  

5) Go to Headings List: (T) "Enter-T". The "Go to Headings List" function only appears when you are 

reading HTML, XML, or EPUB documents, and brings up a list of headings in your current document. 

Use "Space-1" and "Space-4" to move among the headings, and press "Enter" to jump to the current 

heading in the list.  

6) Go to Previous Heading: (P) "Backspace-space-2-3-5". Moves to the previous heading in an EPUB, 

XML, HTM, HTML or DOCX document. 

7) Go to Next Heading: (N) "Backspace-Space-2-5-6". Moves to the next heading in an EPUB, XML, 

HTM, HTML, or DOCX document. 

 

7.5 The Read Menu 

1) Read Selected Text: (B) "Backspace-B". Speaks the text you currently have selected. Note: this 

option is only available in "Manual Reading Mode".  

2) Toggle Reading Mode: (G) "Enter". The "Toggle Reading Mode" option allows you to toggle 

between "Continuous" and "Manual" reading modes. Press "Enter" while reading a document to 

toggle between Manual and Continuous reading. 

3) Read Current Page: (C) "Backspace". Speaks the current page. Read the prior page using "dots-1-

2-6", and read the next page using "dots-3-4-5".  

4) Read Current Paragraph: (P) "Space-2-3-5-6". Speaks the current paragraph. Read the prior 

paragraph using "Space-2-3", and read the next paragraph using "Space-5-6". 



5) Read Current Line: (L) "Space-1-4". Speaks the current line.  Read the prior line using "Space-1", 

and read the next line using "Space-4". 

6) Read Current Sentence: (S) "Space-1-4-5-6". Speaks the current sentence. 

 

7.6 The Mark Menu 

1) Set Mark: (M) "Enter-M". You can set marks while playing a file to note positions you would like to 

return to later. You may set up to 1000 marks per document.  

2) Jump to Mark: (J) "Enter-J". You are prompted for the "Mark name to move to:". Type the mark 

name in the edit box and press "Enter".  

3) Delete a Mark: (D) "Space-D". You are prompted to "Enter mark name to delete". Type it and 

press "Enter".  

4) Next Mark: (N) "Enter-N". The "Next Mark" function allows you to move to a marked location 

ahead of your current position.  

5) Previous Mark: (B) "Backspace-M". The "Previous Mark" function allows you to move to a marked 

location before your current position.  

6) Mark List:  (K) "ENTER-K". Use "Space-1" and "Space-4" to navigate the list, and press "Enter" on a 

mark to go to its location in the document. 

7) Mark Alert Options: (O)  "Backspace-O". You can use the Mark Alert Options" setting to configure 

how you want to be alerted when marks appear in your document as you read. The alert options are 

"Beep", "Message" and "No alert".  

 

8 DAISY Player 
Using the DAISY Player on the Braille eMotion 40, you can listen to files and 

read books that use the DAISY format. DAISY is an acronym for (DIGITAL 

ACCESSIBLE INFORMATION SYSTEM). One advantage to DAISY books 

is that you can listen to the audio as well as read the associated text with the 

audio in DAISY books where both text and audio are present.  



The Braille eMotion 40 supports DAISY books that are version 3.0 or earlier. 

The DAISY Player supports the following book types: 

DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 

ANSI/NISO Z39.86 4002, 4005. 

Bookshare.org DAISY content,  

NIMAS 1.1  

DRM: supports 4006 PDTB2 authentication.  

 

8.1 Arrangement of the DAISY Player 

To launch the DAISY Player, press "Enter" on "DAISY Player" in the Braille 

eMotion 40 main menu. You can also launch the DAISY player from 

anywhere on the unit by pressing "F1-D".  

When you launch the DAISY Player, you are placed in Braille eMotion's drive 

list. Press "Enter" on the drive containing the DAISY book you want to open. 

Use normal folder navigation to locate the folder containing a DAISY book 

you want to open. Press "Space" to select it, then press "Enter" to open it. 

You must first select the folder containing the book, because a DAISY book 

contains multiple files, thus, Braille eMotion 40 needs to know exactly from 

which folder to get all the book text and information.  

If you replay a book that you have listened to before, playback resumes from 

the location where you last exited. To stop playing a DAISY book, press 

"Space-Z". A prompt box appears asking if you would like to exit the DAISY 

Player. Select "Yes" or "No" with "Space" or "Backspace" and press "Enter".  

Open the DAISY Player menu by pressing "Space-M" or "F2". The menu 

contains "File", "Document", "Mark", and "Heading". You can navigate the 

menu items using "Space-1" and "Space-4". To activate a menu item, press 

"Enter".  



Or, you can press "Space-M or "F2" followed by the shortcut for the 

corresponding menu item. For example to open the "Heading" menu, press 

"Space-M" or "F2" to open the menu, and press H.  

The DAISY Player also contains various lists and dialog boxes. Use "Space-

1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings 

or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab 

among controls in a dialog.  

Press "Enter" to execute an item. 

While playing DAISY content, you are placed in a dialog in which four 

controls/components are available: "heading", "Information", "Play" and 

"Pause". "Tab" through this information using "F3".  

"Heading" shows you a prefixed heading or navigation element as well as 

the text under that element if text exists. In "information", you can find the 

current page, level, phrase, elapsed time, and running time. You can move 

among these items with "Space-1" or "Space-4". You can press "Enter" on 

"Pause" or "Play", to pause or play the audio. From anywhere in the dialog, 

you can also toggle play/pause with "Space". 

 

8.2 The File Menu 

1) Open DAISY: (O) "Enter-O". Calls the "Open DAISY" dialog. 

2) Voice Settings: (S) "Enter-S". Set auto playback settings, mark alerts,  and 

rate, pitch and volume of the reading voice. You can also set the reading 

voice among any of the Braille eMotion 40 vocalizer voices you have installed. 

3) Book Info: (I) "Enter-I". Obtain information about the currently playing 

DAISY book. 

4) Exit: (Z) "Space-Z". Closes the DAISY Player. 



5) Exit and delete Bookmark: (Q) “Enter-Z”. exits and deletes any existing 

exit mark. 

6) Exit Without Bookmark: © “Backspace-Z”. Closes without marking your 

exit position. 

 

8.3 The Document Menu 

1) Play/Pause: (P) "Space-P". Pause and resume playback. You can also 

use the "Play" button. 

2) Previous Page: (U) "Dots-1-2-6". Moves back one page. 

3) Next Page: (D) "Dots-3-4-5". Moves forward one page. 

4) Go To Page: (G) "Enter-G". Enter the number of the specific page you 

want to go to. 

5) Go To Percent: ® “Enter-E”. Go to a specific position in the book according 

to percentage. 

6) Go To Time: (T) “Backspace-T”. Available only in DAISY audio: go to a 

position in the book according to the elapsed time. 

7) Move by Previous Movement Unit: (H) "Dot-3". Move back by specified 

movement type. 

8) Move by Next Movement Unit: (L) "Dot-6". Move forward by specified 

movement type. 

9) Change to Previous Movement Unit: (I) "Dots-2-3". Cycle backward one 

movement type.  

10) Change to Next Movement Unit: (E) "Dots-5-6". Cycle forward one 

movement type. 

 



8.4 The Mark Menu 

1) Set Mark: (M) "Enter-M". Bookmark a position. 

2) Jump to Mark: (J) "Enter-J". Move to a previously set mark. 

3) Delete Mark: (D) "Space-D". Delete a previously set mark. 

 

8.5 The Headings Menu 

1) Headings List: (L) "Enter-H". Open the list of headings in the book. 

2) Scan for Next Heading: (N) "Enter-N". Move to the next available heading. 

3) Read Current Heading: (W) "Enter-W". Read the heading under which the 

current text is located. 

4) First Heading: (T) "Dots-1-3". Move to the first heading. 

5) Last Heading: (B) "Dots-4-6". Move to the final heading of the book. 

6) Find: (F) "Space-F". Search for text. 

7) Find Again: (R) "Enter-F". Find the next instance of the search string you 

specified in the "Find" dialog. 

 

8.6 The Memo Menu 

1) Insert Memo: (M) "Backspace-M". Insert an annotation. 

2) Read Memo: (R) "Backspace-R". Read the current memo. 

3) Previous Memo: (P) "Backspace-P". Move back one memo from your 

current position. 

4) Next Memo: (N) "Backspace-N". Move to the next memo from your current 

position. 

5) Delete Memo: (D) "Backspace-D". Delete the current memo. 



 

9 Media Player 
You can use the Media Player to play audio and video files, playlists, or 

Internet media streams. The Media Player supports the following formats, 

ac3, asf, asx, m3u, mp2, mp3, MP 4, mpa, mpg, ogg, pls, wav, wax, wma, 

flac, midi wmv, and MOV.  

You can control the playing of media files using Braille keyboard commands. 

To launch the "Media Player", navigate to it in the main menu and press 

"Enter". Or, launch it from anywhere on the unit by pressing "F1-M". 

 

9.1 Media Player Layout 

The playback dialog contains two information tabs: "playback information" 

and "playlist". Press "F3" or "Space-F3" to move between these tabs. 

The "playback information" tab displays the track number, the file name, and 

the current playback status: (play, pause, or stop). If there are no files in the 

playlist, the Braille eMotion 40 displays "Title: There are no items to display". 

If you press "Space-4", the Braille eMotion 40 displays playback time 

information.  

When in the Playback tab, you can use the cursor routers to jump to specific 

areas of the media file. For example, if you want to move to a place near the 

middle of the file, press cursor router 20 or 21. If you want to move to a place 

near 75%, press cursor router 30. 

The "playlist" tab displays all the files in the playlist. For each file in the 

playlist, it displays the track number, file name, the location of the file in the 

list, and the total number of files in the list. If there is no file in the playlist, the 

Braille eMotion 40 displays the message "no items". 

The Braille eMotion's Media Player supports the viewing of lyrics for MP3 

files which contain them. The "Lyrics tab appears in the tab order only if the 



file you are playing contains lyrics in its file information. The lyrics are 

displayed in a multi edit box which you can read and navigate using normal 

document navigation commands.  

The Media Player menu contains five items: "File", "Play", "Position", "Mark" 

and "Settings".  

To open the Media Player menu, press "Space-M" or "F2". Select a menu 

item using "Space-1" or "Space-4" and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 

"Space-F3" to tab among controls in a dialog.  

Press "Enter" to execute an item. 

 

9.2 The File Menu 

1) Open File: (O) "Enter-O". Opens a media file and creates a new playlist. 

2) Open Folder: (F) "Enter-F". Creates a new playlist with all the media files 

in the selected folder. 

3) Add File: (A) "Backspace-O". Adds the selected files to the current playlist. 

4) Add Folder: (I) "Backspace-F". Adds all the media files in the selected 

folders to the current playlist. 

5) Save Playlist: (S) "Space-I". Saves the current playlist. 

6) Save As Playlist. Saves the currently playing files as a playlist. 

7) Delete Item: (D) "Space-D". Deletes the current item from the playlist. 

8) Tag Information: (T) "Enter-T". Opens the properties for the current media 

file. 

9) Open URL: (U) "Enter-U". Opens a website for streaming playback. 



10) Exit: (Z) "Enter-Z". Exits the Media Player. 

 

9.3 The Play Menu 

1) Play (P) "Enter". Initiates playback.  

2) Previous Track: (B) "Dot-3". Moves back 1 track.  

3) Next Track: (N) "Dot-6". Moves forward 1 track.  

4) Back 5 Tracks: (D) "Dots-2-3". Moves back 5 tracks. 

5) Forward 5 tracks: (U) "Dots-5-6". Moves forward 5 tracks. 

6) First Track: (T) "Dots-1-3". Moves to the first track in the playlist. 

7) Last Track: (E) "Dots-4-6". Moves to the last track in the playlist. 

8) Volume Up: (H) "Space-Up Scroll". Increases the volume. 

9) Volume Down: (L) "Space-Down Scroll". Decreases the volume. 

10) Speed Up: (K) "Dots-3-4-5". Increases the playback speed. 

11) Slow Down: (M) "Dots-1-2-6". Decreases playback speed. 

12) Pause: (A) "Space". Pauses playback. Press again to resume.  

13) Stop: (S) "Backspace". Stops playback.  

 

9.4 The Position Menu 

1) Mark Position: (M) "Enter-M". Marks the current position for later use. 

2) Delete marked Position: (D) "Enter-D". Unmark the marked position. 

3) Jump to Marked Position: (J) "Enter-J". Go to the position previously 

marked. 

4) Go to Time: (G) "Enter-G". Go to a specific time in the file.  



5) Go to Percent: (E) "Backspace-P". Move to a place in the file according to 

its percentage. 

6) Go to Number: (N) “Enter-N”. Takes you to the file with the associated 

number in the current playlist. 

7) Set Start Point: (L) "Enter-P". Set a start point for repeat play. 

8) Release Point: (R) "Space-E". Set the end point for repeat playback. 

9) Chapter List: © “Backspace-L”. Opens a list of chapters if chapter markup 

exists in the file. During playback, press “Space-2-3-6” to move back by 

chapter, and “Space-3-5-6” to move forward a chapter. 

 

9.5 The Mark Menu 

1) Set Mark: (S) "Backspace-M". Bookmark a specific point the media file.  

2) Jump to Mark: (M) "Backspace-J". Move to a previously set mark. 

3) Previous Mark: (P) "Backspace-dot-3". Moves back one mark from your 

current position. 

4) Next Mark: (N) "Backspace-dot-6". Moves to the next mark after your 

current position. 

5) Delete Mark: (D) "Backspace-D". Deletes a mark. 

6) Mark Manager: (K) "Backspace-K". View and modify all marks in the 

current file. 

 

9.6 The Settings Menu 

1) Configuration: (C) "Backspace-C". Lets you configure file information 

display, Mark Alerts, and exit position saving. 



2) Playback Settings: (P) "Enter-S". Settings for Repeat Shuffle and other 

playlist settings. Also allows you to choose whether to show progress of file 

playback position with dots-7-8 on the Braille display. 

3) Effect Settings: (E) "Enter-E". Set Equalizer and bass boost. 

 

9.7 Playing Audio Books 

When playing an audio book, it is likely you will want files and folders that 

make up the book  to be treated differently than a music playlist, both in terms 

of navigation and marked positions. For this reason, files and folders that are 

placed in the “Audiobooks” folder on your flashdisk, SD card, or connected 

USB drive are handled in a different manner from audio files in any other 

location on your device. 

Firstly, regardless of how you’ve set the “save marked position” setting, exit 

marks are saved for all files and folders in the Audiobooks folder, as it’s likely 

you will wish to return to your former position the next time you open content 

from that location. In addition, if you open a folder from within the Media 

player using the “Enter-F” command, these marks apply to the folder as a 

whole, rather than each individual file. * Note: if you open an individual file in 

the Media Player, or from the File Manager, the marked position can apply 

only to that file. 

In the same manner, when accessing a folder within the “Audiobooks” folder, 

any bookmarks you set apply to the book as a whole., Additionally, the “Go 

To Time”, and “Go To Percentage” commands also apply to the entirety of 

the folder rather than the current file as is normally the case. 

To play any folder of audio files as an audio book, copy it to the “Audiobooks” 

folder of the flashdisk or any connected drive. In the Media Player, use the 

“Open folder” command to open the folder as an audio book. By default, 

Android should automatically create the “Audiobooks” folder on any 

connected drive, however, there are some instances where this does not 



happen. If this folder is not automatically created on your connected drive, 

you may create it, and the Media Player will recognize it, and act on it as 

described above. 

 

9.8 Using Background Play 

You may often find that you want to play media while performing other tasks. 

Braille emotion allows you to control media in the background while other 

tasks are in the foreground using hot keys. 

Press the “cursor” key with “Enter” to toggle pausing/playing media. Press 

“Cursor” with “F1” or “F3” to move forward by the selected movement unit, 

and “Cursor” with “F2” or “F4” to move back by the selected movement unit. 

Press the “Cursor” key with the “Input Selector” button in the center of the 

Braille keys to change the selected movement unit. 

 

 

10. Utilities 
The "Utilities" menu provides several special functions and settings for the 

Braille eMotion 40. Move among the items in the "Utilities" menu using 

"Space-1" and "Space-4" and press "Enter" to open an item.  

You can access functions for each program using hot keys, or via that 

program's menus or dialogs. If a program has menus, press "Space-M" or 

"F2" to open the menu. Select a menu item using "Space-1" or "Space-4", 

and press "Enter". Or, you can press "Space-M or "F2" followed by the 

shortcut for the corresponding menu item.  

In dialogs, use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab 

and shift-tab among controls.  



Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

 

10.1 Voice Recorder 

The Voice Recorder application allows you to create MP3 or WAV individual 

recordings, or record DAISY books using WAV or MP3 from the internal 

stereo microphones, a 4-pole headset, or an Android compatible USB 

audio device.  

You can launch the Voice recorder by navigating to the Utilities Menu, and 

pressing “V”, or by short pressing the “Record” button.  

The “Record” dialog contains the “Record” button”, the “Record Settings” 

button, a “Recordings” button, an “exit” button, and a status area. Use “F3” 

and “Space-F3” to move among the controls. 

 

10.1.1 MAKING RECORDINGS 

When you launch the Voice Recorder, the device prompts you to record, and 

displays the source from which you will be recording: “Microphone Record”, 

“USB Record”, etc. You can set the recording source using the “Record 

Settings” dialog described later, or connect a USB source, and the Braille 

eMotion 40 will automatically use it. 

When you see the “record” prompt, you are placed in standby mode. Press 

“Enter” to initiate recording. Press "Space-Z" when finished. You can also 

long press the "Record" button to immediately start recording without prompt. 

Press it again to finish. Use the Cursor button with “Enter” during a recording 

to pause and resume recording. 

 



*Note: The Braille eMotion 40 supports recording and playback through 

generic plug and play USB audio devices, including mixers, USB headsets, 

USB microphones, and other generic USB sound card devices. While many 

devices are supported, be aware that devices that require specialized drivers 

or apps are not likely to work. Nor can you use multi-track recording devices, 

as they generally require a digital audio work station to operate. However, 

most plug and play audio devices that mix down to stereo output will work 

beautifully. 

When using external devices, there are a few things to be aware of: 

i. If a USB source is connected, it will always take priority. 
ii. If more than one USB source is connected, as in the case 

of a camera and second separate audio device, the most 
recently connected source will take precedence. 

iii. USB audio sources completely ignore the Recording 
Source setting, this applies only to internal sources, and 
connecting a USB source makes it irrelevant, as the USB 
source automatically takes over, and cannot be chosen 
using this setting. 

iv. If you connect any headphones, 4 pole or otherwise, 
while a USB source is connected, the USB audio 
connection is canceled, and the recorder will use the 
internal recording source setting.  

v. By default, Braille eMotion 40 audio is silenced during 
recording to avoid loop back issues with some headsets. 
If you want to loop back Braille eMotion 40 audio using a 
mixer, please be sure to turn the “Headphone Monitoring” 
setting and “Mute System Audio While recording” setting 
to off, and use the mixer itself to monitor the output. 

 

10.1.2 MAKING DAISY RECORDINGS 

You can use the Braille Sense's Record function to record DAISY files 

as well as simple WAV and MP3 recordings. To record in DAISY format, 

set the recording method to "DAISY" in the "Record Settings" dialog.  



When you initiate DAISY recording, you are prompted, "Start title recording", 

after which time the Braille Sense gives you about 10 seconds to record a 

title before automatically moving to recording heading 1.  

You can manually insert navigation points in to your DAISY books as you 

record. Type “Backspace-H” to insert a heading. Type “Backspace-P” to 

insert a phrase. Type “Backspace-G” to insert a page. Each time you press 

one of these keys, Braille Sense displays the start of the navigation point: for 

example, "Starting page 8" or "Start heading 3". 

When you stop recording, the unit announces, "building" to let you know the 

DAISY book is being created. Recorded DAISY files are saved to 

flashdisk/DAISY/Record, and can be played in the DAISY Player. You can, 

of course, also locate the individual recordings using the File Manager and 

play them in the Media Player. 

 

10.1.3 PLAYING INDIVIDUAL RECORDINGS 

When you finish creating an individual recording, you are placed on a 

“Play” button so that you can hear what you just recorded. Press “Enter” on 

this button to start playback. Alternatively, you can press “Enter-P” to play 

the currently focused recording. 

To hear previously recorded files, Tab to the “Recordings” button and press 

“Enter”. You are placed in the folder you have set to store recorded files, by 

default, this is set to flashdisk/music/record. You can use normal file/folder 

navigation to access any WAV or MP3 file on the unit, and press Enter to 

start playback. 

During playback, press “Space” to toggle Pause/play, and “Backspace” to 

stop playback. Adjust the volume with “Space-Up/Down Scroll”, and adjust 

the speed with “dots-3-4-5” and “dots-1-2-6”. Use the cursor routers to 

move to various positions in the file, just as you do in the Media Player. 

 



10.1.4 RECORD SETTINGS 

The “Record Settings” dialog contains the following options: 

1) Recording Type: choose between WAV or MP3. 

2) Sample Rate: choose from several increments ranging from 8000 to 

48,000 HZ.  

3) Bitrate: determines the quality of an MP3 recording, does not appear 

when type is set to WAV. Choose from increments ranging from 64K 

to 340K which is CD quality. 

4) Mic Volume: determines the gain of the microphones, Set to High, 

Medium or Low. 

5) Recording Source: microphone will use an external mic if plugged in, 

and the built-in mics if not; Headset will use a 4-pole headset if 

connected and the built-in mics if not; Line In will use a stereo line in 

source if connected and the built-in mics if not. *Note that, if a USB 

device is connected, it will take precedence no matter which option is 

chosen here. 

6) File name Type: determines whether recordings are named by 

number, or by the time and date they were created. 

7) Earphone monitoring: On/Off. Determines whether you hear what is 

being recorded through headphones as you are recording. Note that, 

if earphone monitoring is on, system audio will be muted during 

recording regardless of how that option is set. 

8) Mute System Audio While Recording: on/Off. By default, this is turned 

on so that system audio and TTS do not interrupt what you are 

recording. System prompts are still displayed in Braille. If you wish to 

record system audio for a demonstration, or to record a stream, etc, 

set this setting to off, and use a mixer that offers Loop Back or USB 

Return to send the system audio through to your recording. 

9) Recording Method: Normal or DAISY. The normal Recording method 

creates individual WAV or MP3 files, while the DAISY method builds 



several recordings in to a DAISY audio book as specified by the 

navigation points you create as you record. 

10) Set Folder: determines where individual or DAISY recordings 

are stored. If you choose the Normal Recording method, the default 

folder is flashdisk/music/record. If you choose the DAISY Recording 

method, the default folder is flashdisk/daisy/record. 

11) Record File Name: determines the base file name for 

recordings. By default, this is set as “record”, however, you can edit it 

to your liking.  The rest of the file name is determined by the “File 

Name Type” setting described above. 

 

 

10.2 Calculator 

Using the calculator on the Braille eMotion 40, you can do simple math 

equations as well as complex scientific calculations. The results and 

expressions are displayed in Braille, and spoken by the Braille eMotion 40.  

To use the calculator, press C from within the "Utilities" menu. You can launch 

the "Calculator" from anywhere on the unit by pressing "F3-C". When the 

calculator is opened, 0 is displayed in computer Braille. 

You may type using computer Braille, UEB, or Nemeth Braille when inserting 

expressions. Press "Backspace-G" to cycle the Braille codes. Clear the 

calculator with "Backspace-C". If you insert numbers or a function into a 

result, the result disappears; and if you enter operators, you move to the next 

step. In addition, you can keep your result in the calculator's memory, and 

recall it later. You can activate the functions and operators via the calculator 

menu or you can use the hot keys associated with the various functions.  

 



10.2.1 GENERAL FUNCTIONS 

To access general mathematical operations, open the menu by pressing 

"Space-m or "F2" and press "Enter" on "General Functions". From the 

calculation line, access the "General Functions" by pressing "Enter-G".  

"General functions" is a dialog box that contains the "general function list", a 

"Confirm" button, and a "Cancel" button. You can navigate the operators 

using "Space-1" or "Space-4". Or, you can press the first letter of the operator 

you want to access.  

Select your desired operation and press "Enter" to perform it. You can also 

use hot keys to quickly execute operations. Press "Space-H" for a list of hot 

keys in the Calculator.  

To enter negative numbers type minus (dots 3-6) and the number in 

parentheses. For the percent operation, type the numbers first followed by 

the percent sign. Immediately after you type the percent sign (%), the number 

you have typed in is converted into a percent value.  

 

10.2.2 FRACTIONAL ARITHMETIC 

The Braille eMotion 40 can perform fractional operations such as simplifying 

and multiplying fractions as well as converting fractions to decimals.  

You can also convert fractions to decimals, decimals to fractions, improper 

fractions to mixed numbers, or mixed numbers to improper fractions. When 

your result is fractional, you can bring up the "fraction options" by pressing 

"Space-3-4". Press "Space-1" and "Space-4" to move among the available 

options. If the fraction is a simple fraction, your options are ""fraction to 

decimal" and "return original fraction". If the fraction is an improper fraction, 

you also have an option to return "improper fraction to mixed number". If your 

fraction is a mixed number, the "mixed number to improper fraction" appears. 

Finally, if your result is a decimal and you press "Space-3-4", the decimal is 

converted to a fraction.  



 

10.2.3 MEMORY FUNCTIONS 

The "Memory Functions" act on stored answers and calculations in memory. 

To access these functions, press "F2" to open the menu, and press "Enter" 

on "Memory Functions".  

"Recall Items" is a dialog, containing "Variable list", "Delete", "Display detail", 

"Confirm", and "Cancel". You can access the dialog by pressing "Backspace-

R" in the calculation line or by selecting it from the "Memory Functions" menu.  

The "Variable list" displays "item name: value". Insert the value into your 

calculation by pressing "Enter" on the item name. You can also copy items 

in the "Variable list". Press "Space" to select an item in the "Variable list". 

Then, press "Enter-I" to copy the selected items to the clipboard.  

The "Display detail" shows the item name and its result with the default set 

to "No". To review the detailed information, press "Space" to switch to "Yes". 

Then, it displays "item name: the expression = its result value" in Braille.  

"Delete" is used to remove a variable item from the list.  

You can delete all of the saved items stored in the "Recall Items". Select 

"Delete All Saved Items" from the "Memory Functions" menu, or press 

"Enter-D" from the calculation line. 

"Save Items" is a dialog that allows you to define variables according to the 

current expression or result in the calculator and save them for future use. 

The dialog contains an edit box for typing in the variable name, a "Confirm" 

button and a "Cancel" button. SELECT "Save Items" from the "Memory 

Functions" menu, or press "Backspace-S" from the calculation line.  

When the dialog is opened, the "item name" edit box is focused. Type a name 

for the variable, and press "Enter" or move to "confirm", and press "Enter". 

The current expression or result is then saved under the variable name you 

just specified. 



If you type names under variables which have already been created, you are 

prompted, "Replace variable xx with current value? Yes". If you type function 

names like "sin", "cos", or "pi" as a variable name, you are warned, "Invalid 

item name", as you cannot use these functions in variable names.  

You can also define variables directly from the calculation line by typing 

"variable=expression" and press "Enter" to save the variable.  

 

If you select the Statistics function, a dialog opens, which consists of a list 

box containing all the stored variables and their values, a list box displaying 

the results of several functions, and a "Close" button. Press "Backspace-T" 

to activate this function from the calculation line,  

Press "Space" to select each variable in the list that you want included in the 

data set for which the statistics are calculated. TAB to the "result" list to view 

the sum, average, variance, and standard deviation of the selected variables. 

You can also select items from the result list and copy them to the clipboard.  

 

10.2.4 SINE FUNCTIONS 

Select "Sine Functions" in the Calculator's menu, or press "Enter-S" in the 

calculation line. The "sine function" list consists of "Sine", "Arc sine", and 

"Hyperbolic sine". If you press "Enter" on one of the three functions you can 

insert it into your calculation.  

 

10.2.5 COSINE FUNCTIONS 

Select "Cosine Functions" from the Calculator's menu, or press "Enter-I" 

from the calculation line. The "cosine function" list consists of "Cosine", "Arc 

cosine", and "Hyperbolic cosine". If you press "Enter" on one of the three 

functions, the calculation is performed. Or, you can activate one of the three 

cosine functions by pressing the first letter of each from the list. 



 

10.2.6 TANGENT FUNCTIONS 

You can open the "Tangent Functions" by pressing "Enter-T" from the 

calculation line, or by selecting "Tangent Functions" from the Calculator's 

menu. The "tangent functions" list consists of "Tangent", "Arc tangent", and 

"Hyperbolic tangent". If you press "Enter" on one of the three functions, the 

calculation is performed.  

 

10.2.7 LOGARITHM FUNCTIONS 

You can open the "Logarithm Functions" by pressing "Enter-L" from the 

calculation line, or by selecting "Logarithmic Functions" from the Calculator's 

menu. 

The "Logarithm Functions" is a dialog, which contains a "function list", a 

"Confirm" button, and a "Cancel" button. The function list consists of 

"Common logarithm" and "Natural logarithm". If you press "Enter" on one of 

the logarithm functions, the calculation is inserted into your calculation line.  

 

10.2.8 CONVERT UNIT 

The "Convert Unit" dialog allows you to convert measurements of mass, area, 

volume, distance, and temperature from metric measure to imperial measure 

as well as other standards of measurement and units of measurement within 

the same system. It also converts several units of measurement related to 

programming and computers. 

To open the "Convert Unit" dialog, Select "Convert Unit" from the Calculator's 

menu, or press "Enter-U" from anywhere in the Calculator.  

The "Convert Unit" dialog contains the following items: "Unit Category" 

combo box, "Current Unit" combo box, "Change Unit" combo box, "Input 

Number" edit box, "Convert" button, "Cancel" button and the "Result" static 



box. You can move among the controls in the dialog using "Tab (F3 or Space-

4-5)" or "Shift-Tab (Space-F3 or Space-1-2)". Use "Space-1" or "Space-4" to 

move among the items in the combo boxes.  

The available unit categories are Distance, Area, Mass, Volume, 

Temperature, Data, numbers and Text. When you have chosen your 

measurement category, the "Current Unit" and "Change Unit" combo boxes 

will contain measurement units according to your chosen category. The 

available distance units are: Millimeters, Centimeters, Meters, Kilometers, 

Inches, Feet, Yards, and Miles. The available units of area are: Square 

Meters, Are, Square feet, Square Yards, Acres, and Hectares. The available 

units of mass are: Grams, Kilograms, Tones, Grains, Ounces, and Pounds. 

The available units of volume are: Deciliter, Milliliter, Liter, Cubic Centimeter, 

Cubic Meter, Cubic Inch, Cubic Foot, Cubic Yard, Gallon, Fluid oz, Cups and 

Quarts. The available units of temperature are: Celsius, Fahrenheit and 

Kelvin.  

The available data units are bit, byte, kilobyte, megabyte and gigabyte. The 

available numeric units are Hex, Dec and binary. Finally, the text conversion 

allows you to discover the ASCII equivalent to any text character. 

Choose your unit to convert from in the first combo box. Choose your unit to 

convert to in the "Change" combo box. Type the number of the measurement 

you want to convert in the "Input Number" edit box. Finally, to convert the 

measurement, Tab to the "Convert" button and press "Enter". If you wish to 

cancel the conversion, Tab to the "Cancel" button and press "Enter". When 

you activate the "Convert" button, the conversion result is displayed in the 

"Result" static box.  

 

10.2.9 COPY TO CLIPBOARD 

The "Copy to Clipboard" function is used to copy your expression or result to 

the clipboard for pasting your expression or result in a document. You can 



also access up to 40 lines of calculation history and copy them as well. Press 

"Enter" on the "Copy to Clipboard" option in the menu, or press "Enter-C" in 

the calculation line to copy the current expression. You can now paste the 

calculation to a document in the Notepad or to another application on the 

unit.  

To access the cumulative calculation history, press "Enter-H". You can then 

use normal selection commands to select the lines of the history you wish to 

copy. Press “Space-D” to delete an item from the cumulative history. 

 

10.2.10 RETURN FORMULA 

There may be times, after viewing a result, that you wish to be reminded 

what expression you used to obtain that result. The "return formula" function 

allows you to return the expression you just entered 

When your result is displayed, press "Enter-R", or select "Return Formula" 

from the menu.  

The expression you entered to obtain your current result is displayed. 

 

10.2.11 OPTION SETTINGS 

You can activate the "Option Settings" by pressing "Enter" on the menu 

option, or from your calculation line, press "Enter-O".  

The "Option Settings" dialog contains combo boxes for changing various 

settings, an "OK" button, and a "Cancel" button. The "available settings are 

"Angle Unit", "Calculator Braille Code", “decimal places to display” and 

“Display Using Scientific notation”. You can navigate among the controls 

using “F3” or “Space-F3”. Use "Space" to change the value of each setting. 

When setting the angle unit, if you select "Radian", you can get the PI value 

while using the trigonometric function. If you select "Degree" and activate PI, 

you will get a wrong answer as this is not a valid calculation.  



You can set the Calculator Braille code to computer Braille, Nemeth or UEB 

math Braille as described previously. You can use "Space-G" to change this 

setting from anywhere in the calculator. 

 

10.3 Display Time and Date 

Use this function to check the current date and time. Navigate to "Display 

Time and Date" in the "Utilities" menu, and press "Enter". You can also query 

the time and date from anywhere on the Braille eMotion 40 with "Space-T" 

or by long pressing the “Volume Up” button. You can Tab to display today's 

date. 

 

10.4 Wake Up Alarm 

You can use this function to set multiple alarms to remind you of recurring 

events, or wake you up at different times on varying days of the week. To 

open "Wake up alarm", from the "Utilities" menu, use "Space-1" or "Space-

4" to navigate to "Wake up alarm", and press "Enter". You can launch the 

"Wake Up Alarm" from anywhere on the unit by pressing "F3-A" If you have 

not yet set the time or date in the Braille eMotion 40, the unit prompts, "Set 

time:" After you set the time, the Braille eMotion 40 displays the "Wake up 

alarm" dialog.  

The “Wake Up Alarm” dialog contains 5 items: Alarms list, an “Add” button, 

“Modify” button, “Delete” button, and a “Close” button. Use “F3” and “Space-

F3” to move among the controls. Use “Space-1” and “Space-4” to navigate 

the Alarms list. You can also add an alarm by pressing “Enter-A”, modify with 

“Enter-M”, and delete an alarm with “Space-D”. 

The "Add alarm" dialog contains: "Set time", "Bell", "Term", "Alarm duration", 

"Repeat interval", "Wake up call times", a "Confirm" button, and a "Cancel" 

button.  



When the alarm sounds, the Braille display displays the message "Wake up 

alarm. Press Escape to stop the alarm".  

When you open the "Wake up alarm" dialog, the Braille eMotion 40 displays 

the "Set time" field. The value is set to the current time or the time specified 

previously. Here you can directly type the time, or set the time using the 

shortcut keys, as explained in section 8.1.3.  

Tab to the next field and select from one of 3 alarm sounds, a vibration, a 

media file or an FM Radio frequency for the wake up alarm. Press "Space-

1" or "Space-4" to change the alarm sound. As you move among the sounds, 

the various alarm sounds are played. When you reach the 4th option, 

"Vibrate motor", the Braille eMotion 40 produces a long vibration 

representing the one you would feel should you choose to use this option to 

alert you of your alarm.  

If you choose "Media File", Tab to the "File Name" button and press "enter" 

to browse for the file you wish to use as your alarm sound. You are placed in 

a File Manager control with the focus inside the 'Media" folder. Locate the file 

you wish to use, and press 'Enter". If you choose "FM Radio", tabbing once 

places you in an edit box in to which you can type the frequency of the radio 

station you wish to wake up to.  

When you have selected your desired alarm type, Tab to the next field. 

In the term field, you can set which days of the week the alarm sounds. There 

are four options: "Off", "Once", "Week days", and "Every day". If the "Term" 

is set to "Off", the alarm does not go off at the specified time, no matter how 

the other options in the dialog are set.  

The duration option sets the amount of time that the alarm sounds. The 

options are 1 minute, 2 minutes, or 3 minutes. If you set the ringing duration 

to "1 minute", the alarm sounds for one minute, and then is silent. To stop 

the alarm before a minute has passed, press "Backspace-enter". 



The repeat interval defines the amount of time that is between the times that 

the alarm sounds. For example, if you set the repeat interval to three minutes, 

after the alarm has stopped sounding, it rings again in 3 minutes. The 

available settings are 1, 3, 5, 10, 15, or 40 minutes.  

If the alarm is not turned off by pressing "Backspace-enter", it repeats 

according to the number of times you set the Wake Up Call Time option. The 

available settings are 1 to 10.  

Press "Enter" to save your setting, or "Space-Z" to cancel setting the alarm. 

 

10.5 Stopwatch 

You can launch the "Stopwatch" from anywhere on the unit by pressing "F3-

W". Or, you can navigate to it in the "Utilities" menu and press "Enter". 

"00:00:00" is displayed. Press "Enter", to start the stopwatch running. Press 

"Enter" again, to pause, and the Braille eMotion 40 announces the elapsed 

time, and displays it in Braille. Pressing "Enter" again restarts the stopwatch 

running. 

If you press "Backspace" while the stopwatch is paused or running, The 

Braille eMotion 40 announces the elapsed time and clears to "00:00:00". 

While the stopwatch is running, pressing "Space" gives you the elapsed time. 

As the stopwatch is still running, the Braille display continues displaying the 

time second by second as it passes.  

Press "Space-F2" to stop displaying the time. If you press "Space-F2" once 

more, the time is displayed again. 

Tab to switch to the "Countdown timer". You are asked to type hours, minutes, 

and seconds. Type a two-digit number for the hour, minute, and the second 

using Computer Braille or grade 1. You do not need to use a number sign. If 

you press "Enter" without typing any numbers, the "Countdown timer" starts 



counting down by the default time, which is set to one minute. When started, 

the "Countdown timer" displays "countdown xx minute", and begins running. 

Press "Enter" on the "Countdown timer", and the Braille eMotion 40 tells you 

the remaining time, and pauses countdown. Press "Enter" again to restart 

the timer. Pressing "Backspace" clears the "Countdown timer". If the timer 

reaches zero, a 10-second alarm sounds, and the "Countdown timer" clears. 

If you press "Backspace-enter" while the alarm is sounding, the alarm stops 

and your timer clears, and is ready to accept a new time. 

To exit the "Stopwatch" program, press "Space-Z".  

10.6 Backup/Restore Flashdisk 

The Backup/Restore Flashdisk utility lets you create a password protected 

zip backup of your flashdisk data to an SD card or connected USB drive. You 

can execute this utility by pressing “K” from within the Utilities Menu, or “F3-

P” from anywhere on the unit 

You are placed on the “Backup” button, which also announces the amount of 

data to be backed up. You can press “f3” or “Space-F3” to access the 

“Restore” and “Close” buttons. 

Pressing “Enter” on the “Backup” button places you in a list of available 

drives to which you can save the backup, each announcing the amount of 

free space available. Press “Enter” on the drive you wish to use. 

*Note: We recommend using ExFat SD cards or drives 64GB and above. It 

is not possible to create a zip file of more than 4 GB of data to a FAT32 drive 

or card, and most backups will be larger than 4 GB, as the user flashdisk can 

hold nearly 44 GB of data.  

When you have chosen your drive, you are asked to create a password. If 

you wish to password protect your zip backup, type a password of no more 

than 8 characters in the computer edit box. Press F3 to re-type the password. 



If you do not wish to use a password, Tab once more to “Don’t use password”, 

and press “Enter”. 

Braille eMotion 40 creates a compressed backup, announcing the progress 

as a percentage. When finished, the unit then updates the file system. This 

may take a few minutes. Finally, you are asked whether you want to unmount 

the disk. If you want to disconnect the drive immediately, please choose yes, 

or the file system may not remain intact. If you intend to leave the disk 

connected for a time, you can say no. When you disconnect later, the system 

should be fine. 

When the backup is complete, a folder called “Braille eMotion Backup” 

appears on the root of the backup drive, containing a zip file with the Braille 

eMotion 40 device name and the time and date. 

To restore a backup, choose the drive, then the backup file from the restore 

dialog. If you password protected your backup, you are prompted to enter 

the password before the restoration begins. 

 

10.7 Format 

WARNING!! The Braille eMotion 40 makes it possible to format the flashdisk 

to solve corruption problems and/or start over with a clean internal drive. 

Formatting the flashdisk erases everything on the flashdisk. Be extremely 

cautious when executing this command. If you execute this command, you 

will lose all of your data. You will NOT be able to retrieve this data once the 

command is executed. To format the flashdisk, press and hold the “Home” 

key while powering up from a complete shut down. 

You can also access the "format" function by pressing F from the "Utilities" 

menu. Or, you can launch it from anywhere on the Braille eMotion 40 by 

pressing "F3-F".  



When you format any disk on the Braille eMotion 40, all information is erased. 

Therefore, before you format, you are advised to backup any important data 

if possible. 

 

1) From the Utilities menu, press "Enter" on "Format" and "flashdisk" is 

focused. Press "Enter", or choose another disk from the list, and press 

"Enter". *Note: the disk will be formatted according to its current file system, 

FAT32 or ExFat. 

2) You are prompted, "Format flashdisk?" Yes". Press "Enter" 

3) You are prompted, "All data will be lost. Continue? Yes". Press "Enter".  

4) The unit announces, "Now formatting flashdisk" and the format is started. 

5) When the format is complete, you are returned to the "Disk" list. 

To cancel the format, press "Space", or press "Enter" on "No" in step 2 or 3. 

 

10.8 Set Sleep Timer 

You can set the sleep timer to turn the Braille eMotion 40 off after a specified 

amount of time regardless of what you are doing. 

To set the Sleep Timer, navigate to "Sleep Timer" in the Utilities" menu and 

press "Enter". Or press "Space-J" from anywhere on the unit.  

You are prompted, "Sleep timer: 0". Enter the number of minutes for the sleep 

timer in the edit box. The available settings range from 0 to 180. Press 

"Enter". 

When the sleep timer is set, even if the device is active, it powers off after 

the specified amount of time. If you set the sleep timer for "5" minutes and 

press "Space-J (dots 2-4-5)" after 2 minutes, "3" is displayed in the edit box, 

indicating the time remaining before the sleep timer powers the unit off.  



 

10.9 Upgrade Braille eMotion 40 Firmware 

Using this utility, you can update the Braille eMotion 40 either via an Internet 

connection or from external media containing the upgrade files. If you choose 

the "Online" method, be sure you have an active Internet connection before 

attempting the upgrade. When you update the Braille eMotion 40, settings 

are usually maintained. However, if there are changes to setting values in 

the firmware, all settings will be initialized. Therefore, it is recommended that 

you back up your settings using the backup/restore utility in the “Settings” 

menu. Data in the flashdisk is protected. However, we recommend you 

backup your files before updating the Braille eMotion 40 Firmware as 

unexpected problems can occur. 

⚫ Note: You cannot cancel the update once it has started. You must not 

reset the unit during an upgrade. You must keep the unit connected to 

AC power throughout the upgrade process. We recommend you do 

not touch the Braille eMotion 40 while it is updating. It may take up to 

60 minutes to update the Braille eMotion 40, possibly even longer 

depending on the speed of your Internet connection and how many 

apps you have installed.  

⚫ Also note: the upgrade files are temporarily stored on the flashdisk for 

installation. If you do not have enough memory available on the 

flashdisk, the Braille eMotion 40 is unable to update until you make 

room for the upgrade files. 

You can access the "Upgrade Firmware" option via the "Utilities" menu, or 

launch it from anywhere on the unit using "F3-U".  

When you have chosen your upgrade method, and the upgrade files are 

downloaded or detected, Braille eMotion 40 will extract all of the necessary 

program files. Progress is announced every few seconds. 



Once done, the Braille eMotion 40 will reboot, and the system files will be 

upgraded. During this process, there is no speech, but the progress will be 

shown in Braille as a percentage. 

Once this has completed, all the applications will be upgraded. 

When the system files have been upgraded and the applications initialized, 

the software will load and boot. During this process, the Braille eMotion 40 

displays “Starting Braille eMotion” in Braille, and a progress indicator of 

changing dots appears on the right.  

When the system reboots, if there are no new or changed setting values in 

the firmware, the Main Menu loads, and your settings are restored. If setting 

values have been changed, all Settings are initialized, and the system boots 

and runs the Quick Guide. 

When the system boots for the final time after the upgrade, the release Note 

is displayed. Press “F4” to exit to the Main Menu. If you want to save the 

release Note to the Documents folder, Tab to save and press “Enter”. To 

display it again at any time, press “F2-F3-R” from the main Menu. 

 

 

10.9.1 UPGRADING THE BRAILLE EMOTION 40 FIRMWARE 
USING THE INTERNET 

To upgrade the Braille eMotion 40 Firmware via the Internet, follow these 

steps: 

1) Make sure you are connected to the Internet and plugged into AC power. 

Press "Enter" on "Upgrade Braille eMotion Firmware" in the "Utilities" menu.  

2) Press "Enter" on "Upgrade: Online". The Braille eMotion 40 connects to 

the HIMS server, and your current software version is compared to the HIMS 

server version. You are prompted to continue with the upgrade. 



3) The Braille eMotion 40 begins downloading the upgrade files. The upgrade 

is around 1.3 GB. Thus, depending on the speed of your Internet connection, 

it may take a long time to download. If the upgrade fails, you may receive the 

message, "Internet connection is not available. To try the upgrade again, 

press "Space-Z" to cancel, and activate "Upgrade Braille eMotion Firmware" 

again. If the connection is successful, the upgrade files are downloaded. 

4) After downloading the upgrade files, Braille eMotion 40 automatically 

starts the upgrade process. Please remember you must not touch the Braille 

eMotion 40 until the upgrade is complete, as pressing keys, resetting, or 

unplugging the unit can interrupt the upgrade process, thus resulting in an 

incomplete installation. When the upgrade is complete, you are returned to 

the "program" menu, and the unit announces, "File manager". 

5) After the upgrade is complete, check the software version by pressing 

"Space-V" while in the "program" menu. 

 

10.9.2 UPGRADING THE BRAILLE EMOTION 40 FIRMWARE 
FROM A DISK 

To upgrade the Braille eMotion 40 Firmware from a disk, follow these steps: 

1) Download the upgrade file from the HIMS website. Note: the file is a .bin 

file, however, some versions of Windows may rename it as a .zip file. Do not 

extract this file. Simply rename the extension back to .bin. Copy the file to 

the root of an external storage device such as an SD card or USB thumb 

drive.  

2) Connect the SD card or USB drive to the Braille eMotion 40, and be sure 

the Braille eMotion 40 is connected to AC power. Then, press "Enter" on 

"Upgrade Braille eMotion Firmware" from the "Utilities" menu. 

3) "Upgrade: Online" is displayed. Press "Space-4" to go to the "Upgrade: 

Offline" option. Press "Enter".  



4) If you are already running the latest version of the software, you are asked 

to continue with the upgrade. If you press "Enter" on "No", the upgrade is 

cancelled. Press "Space" to toggle between "Yes" and "No".  

5) The Braille eMotion 40 starts the upgrade process. Please remember you 

must not touch the Braille eMotion 40 until the upgrade is complete. When 

the upgrade is complete, you are returned to the "program" menu, and "File 

manager" is displayed. 

6) When the upgrade is complete, check the software version by pressing 

"Space-V" while in the "program" menu. 

 

11. Getting Help 
The “Help” menu  consists of a navigable version of the Braille eMotion 40 

User Guide, as well as general information about your Braille emotion. To 

access the User Guide, open the “Help” menu, and press “Enter” on “user 

guide”. 

You can also launch the User Guide from anywhere on the unit using "F1-H".  

The User Manual will load, and you will be placed in the Navigation menu. 

Use "Space-dot-1” and “Space-dot-4" to navigate to the section you wish to 

read. To navigate to sub sections for the focused section, press F3. Then, 

use “Space-1” and “Space-4” once again to navigate the sub sections. To 

move back a level in the structure, press “Space-F3”. 

Press "Enter" on the focused section to open the manual at that location and 

start reading. Keys for navigating are the same as those in the Notepad. For 

a list of navigation keys, please see chapter 5. You can return to the 

Navigation menu at any time by pressing “Space-N”.  

As you read the manual on the Braille eMotion 40, you can search for text 

by pressing "Space-F". Type the text you wish to find, and press "Enter". You 



can find the next occurrence of the particular text you searched for by 

pressing "Enter-F".  

The Introduction section gives a physical orientation to the Braille eMotion 

40 and an overview of its functionality.  

The section, "Basic Functions", gives a basic overview of the programming 

and operation of the Braille eMotion 40  

The section, "Customizing your Braille display" provides an explanation of 

time and date setup, internet Setup, Bluetooth connectivity, and the “Braille”, 

“Voice” and "Global Options" and how to use them to configure your Braille 

eMotion 40 according to your preferences.  

Most of the remaining sections cover each of the functions of the Braille 

eMotion 40 in detail.  

The "Commands Summary" section is a quick reference of hot keys for all 

the programs on the Braille eMotion 40, useful when you simply want to know 

the keystroke for performing an action without reading the entirety of the 

instructions on a given program. 

You can also get help related to the specific task you are performing. Use 

"Space-H" within any program to get a list of keystrokes available in that 

program. 

 


